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Chapter 1
Installing and
Getting Started

Chapter 1 tells you how to install Fetch, and

describes how to catalog your files.
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2 Aldus Fetch User Guide

What is Aldus Fetch?

Aldus Fetch is a file-management tool designed for graphics profession-

als working with mixed media. Fetch lets you catalog files—images,

movies, sounds, and text, for example—in a common visual catalog, and

then view, edit, copy, and retrieve the files from the catalog and transfer

them to other documents. You can accomplish all this regardless of for-

mat, location, or the applications that created the files.

In a catalog, Fetch stores thumbnail images and pointers to the actual

files. Because Fetch does not store the files themselves, using a catalog

is fast and efficient.

A single catalog can contain over 100,000* items. To each item in a cata-

log, you can add:

• an unlimited number of keywords (each up to 31 characters long) that

let you easily search a catalog.

• a description (up to 32,000 characters long) that lets you store impor-

tant or useful information about the file.

Single-User Fetch is intended specifically for the graphics professional

working independently who needs to manage images, templates, and

other important mixed-media projects.

The multiuser version of Fetch is intended for a graphics workgroup. With

the multiuser version of Fetch installed on their computers, members of

your workgroup can simultaneously search, view, and use items from

catalogs whose source files are located on one or many network servers

or shared volumes. In a workgroup setting, you can allow all users full

access to all functions, or you can designate catalog administrators to

create, maintain, and control access to catalogs for the entire workgroup.

You don’t have to worry, however, about compatibility between Single-

User Fetch and the multiuser version. Single-User Fetch lets you convert

your catalogs for use in Fetch’s multiuser environment (see “Making a

catalog shareable” in Chapter 3). In addition, you can convert shareable

catalogs for use by Single-User Fetch.

The Aldus Fetch User Guide describes both the multiuser version of

Fetch and Single-User Fetch. Differences between the two versions are

noted in the text.

* As the number of items in catalogs increases, common operations will require more memory and time to
complete.
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Installing and Getting Started 3

Make sure you have the proper equipment

To install and use Aldus Fetch, we recommend that you have a 68020-

based Macintosh or higher, 5MB or RAM or more, and System 7. In ad-

dition, we recommend QuickTime 1.6.1 and Macintosh Easy Open, both

of which are installed when you install Fetch.

At the very minimum, you’ll need a 68000-based Macintosh, 4MB of

RAM, System 6.0.7, QuickTime 1.5 or 1.6, and Color QuickDraw 1.2

(required on older Macintoshes).

If you plan to catalog and view files that are typically quite large (for

example, compressed images or KODAK Photo CD images), you’ll

need at least 5MB of RAM or more.

Without QuickTime, you can run Fetch but cannot play sounds or mov-

ies or view 32-bit thumbnails. Using the minimum configuration without

Color QuickDraw, you can run Fetch but you will not be able to preview

color items.

Although Fetch runs under System 6.0.7 or later, we strongly recom-

mend that you use System 7. A number of features—including the ex-

tensive Balloon Help—work as described only if you are running

System 7. Throughout this user guide, you will find the “7” symbol in

the margin next to descriptions of features that work only on Macintosh

computers running System 7.

7
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4 Aldus Fetch User Guide

3. Insert Disk 1 and double-click

Insert Disk 1 in any drive on your Macintosh, double-click the Aldus

Installer/Utility icon, and then follow the instructions on the screen.

For a list of installed files and their locations, see Appendix B.

Important: The Installer does not ask you for a serial number when you

install Fetch (as it does when you install most other Aldus products).

Instead, you’ll be prompted to supply your name, company name, and

Fetch serial number the first time you start Fetch.

Double-click on this icon

Installing Aldus Fetch

1. Make a backup copy of your disk set

Before you install Fetch, make a backup copy of each of the program

disks included in your package. We recommend that you lock the

backup disks after you create them to prevent accidental erasing or over-

writing of files. Use the backup disks to install the program. Be sure to

store the original disks in a safe place.

Note: Your backup disks must have the same names and disk contents as

the original Fetch disks. To ensure that you make an exact duplicate of

the original disks, use the following procedure: insert a blank disk in any

drive on your computer, choose “Eject Disk” from the Special menu,

insert the original program disk, then drag the icon of the original disk

over the icon of the blank backup disk.

2. Restart with extensions off

To ensure that there are no conflicts with any extensions, you should

restart your computer with extensions off (System 7 only). While restart-

ing your computer, press and hold down the Shift key until you see your

Macintosh say “Extensions off.” It’s also a good idea to turn off any

virus protection utilities. (Remember to turn these utilities back on after

you complete installation.)

Troubleshooting Installation

• Carefully read the ReadMe file in

the Main Window of the Installer. If

there is any late-breaking informa-

tion about installing Fetch, you will

find it here.

• If the Installer appears to stop on a

particular disk, check to see whether

you have a bad disk by dragging the

disk’s icon to your hard drive. If the

disk is bad and the copy cannot be

completed, your computer will dis-

play a message. Call Aldus Customer

Services for a replacement disk.
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4. Restart with extensions on

After installation is complete and before starting Fetch for the first time,

you must restart your computer to enable QuickTime and Macintosh

Easy Open so that you can use Fetch with all its features. Easy Open pro-

vides file filters to let you catalog GIF and Targa file types in Fetch. In

addition, Easy Open provides you with alternatives for opening and con-

verting files (see the online Easy Open User Guide).

The first time that you restart your computer after installing Fetch you

will notice that your system is rebuilding its desktop. Macintosh Easy

Open uses this process to find out what applications you have on your

hard drive and what file formats those applications can work with.

After you start using Fetch, an Aldus Fetch™ Preferences folder will be

created and added to the Preferences folder in your System folder. This

new folder contains three files:

• Aldus Fetch™ Exclusions—a file that contains the names of files you

do not want to catalog.

• Aldus Fetch™ Key—a file that contains the serial number that you

enter the first time you start Fetch. If you delete this file, Fetch

prompts you to enter the serial number again the next time you start

the application.

• Aldus Fetch™ Prefs—a file that contains any settings you change

using the “Preferences…” command in the Edit menu and any search

definitions you create using the “Define…” command from the Search

menu.

Note: If you are using System 6.0.7 or 6.0.8, these three files will be

added to your System folder.

5. Register your copy of Aldus Fetch

To receive the technical and customer services that Aldus provides for

registered customers of Fetch, complete and return the registration card

included in your package. Tear off and keep the perforated end of the

card. By registering, you’ll also receive a free trial subscription to Aldus

Magazine.

Affix the product serial number stickers in handy locations (such as the

inside cover of this manual and on one of the product disks), so that the

number is easy to find when you need it. You will need your product

serial number if you call Aldus Customer Services or Technical Support.
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6 Aldus Fetch User Guide

Cataloging your files for the first time—easy step by step

Now that you’ve installed Fetch, you’d probably like to catalog one or

more of your files, to see how Fetch displays them. (If you don’t have

any files to catalog yet, you can look at the sample catalog. See “Using

the sample catalog.”)

Cataloging your files is as easy as drag-and-drop:

1. Drag and drop

Select a file or folder and drag it over the Fetch application icon. When

the icon is highlighted, release the file or folder.

If you have not already started Fetch, the application is automatically

launched and the product screen appears for a moment.

2. Create a new catalog

After the product screen, a prompt appears, asking you to open an exist-

ing catalog or create a new one. Since you have not yet created a catalog,

click on “New.”

3. Choose location of catalog file

When you create a catalog, Fetch creates a catalog file, which it stores on

your hard drive. In the file location dialog box, which appears next, type

in a name for your catalog and choose its location.
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4. Select Options

Fetch presents you next with the Add/Update dialog box, which lets you

choose a variety of options when you catalog files. For most files, the

default settings should be fine. (See “Setting catalog update options”

for␣a detailed description of these Add/Update options.)

For now, you can just click on the “Continue...” button.

Next you’ll see a series of three status windows appear. The first small

window shows Fetch scanning the files and folders that you dragged

over the Fetch application icon. For a small number of files, this window

may appear for only a second or two.

The second, larger status window shows the files as they are being added

to the catalog. In this window, you’ll see two pictures (or thumbnails) of

each file. On the left is the 8-bit or 32-bit thumbnail and on the right is

the 1-bit thumbnail. (For more information about the different types of

thumbnails, see “Setting catalog update options.”)

After all your files have been cataloged, you’ll see an Add/Update sum-

mary window. The “Added” line shows the number of files that were

cataloged. This number should correspond to the number of files you

dragged over the Fetch application icon. The “Updated” line shows the

number of files that were updated. Since you did not update any files this

time, this number should be zero.

Click on “OK.”
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5. Find items in the catalog

Now you’ll see the Find window. This window lets you search for spe-

cific items in your catalog, using keywords that you have added or key-

words that have been automatically added, such as file name and folder.

(For more information, see “Searching through a catalog” and “Organiz-

ing a catalog by adding keywords.”)

To view all the files you’ve just cataloged, click on “Find All.”

6. View your files

You should now see all the files that you cataloged in the Gallery win-

dow. If you have cataloged files that do not have thumbnails attached to

them (such as text files), then you will see a file icon instead of the

thumbnail. (For help on attaching thumbnails to files, see Using Fetch

with Other Products.)

There are two points to note about the Gallery window. First, the Gallery

window displays the result of a search in a specific catalog. To view files

that you have added to a catalog, you always need to use the Find win-

dow.

Secondly, the thumbnails displayed in the Gallery window are only ref-

erences to the actual files. The files themselves can be stored anywhere.

However, in order to accomplish certain tasks in Fetch, you will need

access to the files.
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Using the sample catalog

If you have not yet cataloged any of your own files, or if you’d like to

work with other file types (such as movies and sounds) that you may not

yet have, you can use the sample catalog to explore Fetch. During instal-

lation, a Sample Catalog folder was placed in your Aldus Fetch folder.

Before you use the sample catalog, you should update it to reflect the

new location of its source files (on your hard drive rather than on the

drive from which they were originally cataloged). If you do not update

the sample catalog, you will only be able to display thumbnails in the

Gallery window; you will not be able to preview the catalog items.

..... To update all Sample Catalog items at once:

1. Open the catalog by double-clicking on the Sample Catalog icon.

The Find window appears before a catalog is displayed.

2. Click on “Find All” in the Find window.

This locates and displays all the items in the Sample Catalog.

3. Choose “Select All” from the Edit menu.

4. Choose “Update Now” from the Admin menu.

Fetch looks for a source file for each item in the catalog and prompts

you for a new location. Click “Open” for each item.

5. Click “OK” after all the files have been located.

..... To update Sample Catalog items one at a time:

1. Open the catalog by double-clicking on the Sample Catalog icon.

2. Click on “Find All” in the Find window.

3. Double-click on the thumbnail to preview the item you want.

4. When prompted, locate and open the file in the Sample Catalog folder

using the file directory dialog box that Fetch displays.

5. Click “Update” in the next dialog box.

6. Close the Preview window.

7. Repeat Steps 3-6 for each item in the Gallery window.
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Where to turn next

Where you turn next in this user guide will depend on how you will be

using Aldus Fetch:

• If you will be primarily using catalogs created by someone else in a

workgroup, turn to Chapter 2, “Using Catalogs.”

• If you will be responsible for creating and managing catalogs either

for others or for yourself, turn first to Chapter 3, “Creating and Man-

aging Catalogs,” and then to Chapter 2.

Sources of information about Aldus Fetch

Name Description

Aldus Fetch User Guide A short manual that provides basic procedures, strategies, tips, and shortcuts for

using Fetch.

Keywording Strategies A short booklet that outlines how to develop a keywording strategy for indexing

(multiuser version of Fetch only) catalog items and how to apply that strategy in Fetch.

Balloon Help Detailed online information about individual commands and dialog box options.

Choose “Show Balloons” from the Help menu, then move the mouse pointer to

whatever item on the screen you want information about. System 7 only.

Fetch Shortcuts An online summary of shortcuts for moving within and among windows in Fetch.

Under System 7: Choose “Fetch Shortcuts” from the Help menu on the main menu

bar. Under System 6: Choose “Fetch Shortcuts” from the Apple menu.

Aldus Fetch Introduction A QuickTime movie that provides a quick online introduction to Fetch. To view the

movie, open the sample catalog as described in “Using the sample catalog,”

double-click the movie’s thumbnail, and then follow the instructions on the screen.

ReadMe Two text files that contain late-breaking information about Fetch that was not

ReadMe (Networks) available when this book went to press. ReadMe contains general program

(multiuser version of Fetch only) information; ReadMe (Networks) contains additional details about using Fetch

in a multiuser environment. You can open both ReadMe files from within the Aldus

Installer/Utility program. Or double-click either file’s icon to read it using TeachText.

We also recommend that you print these files and keep them with your Aldus Fetch

User Guide.
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Chapter   2
Using
Catalogs

Chapter 2 describes how to start Aldus Fetch,

open a catalog and search for items, and then

select, preview, and use those items in a variety

of ways. You’ll also learn how to “work smarter”

using Fetch—by setting appropriate startup

options, using the Pasteboard window as a tem-

porary staging area, and creating collections of

items called projects.

This chapter assumes that you have an existing

catalog with which to work.
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Starting Aldus Fetch and opening a catalog

You can start Aldus Fetch and open a catalog in any of these three ways:

Depending on your startup options, the catalog opens to one of the

two␣primary windows in Aldus Fetch: the Find window or the Gallery

window.

• In the Find window, you describe what you want Fetch to display in

the Gallery window.

• From the Gallery window, you can open one or more Preview and

Info windows that let you view more information about individual

items.

Double-click a catalog icon.
7

Drag a catalog icon onto the Fetch
application icon until both icons are
highlighted, then release.

Double-click the Fetch icon, then choose
“Open…” from the File menu. If you have a
default catalog, double-clicking the Fetch
icon automatically opens that catalog.
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Using Catalogs 13

Gallery window/Thumbnail view: Displays the results of a search. Shows

a separate thumbnail image of each item, with the filename, file type,

and volume below the thumbnail. For more information about the

Gallery window, see “Viewing search results.”

Primary windows in Aldus Fetch

Find window: Lets you describe what you want Fetch to display in the

Gallery window, whether you want all the items in the catalog or only

items with a particular filename, keyword, file type, or volume. For

more information on searching, see “Searching through a catalog.”

Gallery window/Text List view: Lists the items currently in the window,

one row for each item. Also shows the thumbnail, keyword list, and

description for the selected item. For more information about the

Gallery window, see “Viewing search results.”
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14 Aldus Fetch User Guide

Secondary windows in Aldus Fetch

Preview window: Displays a full-size preview of the item. Fetch must be

able to locate the source file before displaying the preview. For more

information about previewing catalog items, see “Previewing an item.”

Info window: Displays all of the information about an item that the

Fetch database contains or that can be read from the source file. To

learn more about information windows, see “Viewing item or catalog

information.”
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Two other windows, the Catalog Info window and the Pasteboard win-

dow, can also be useful as you work in Fetch. The Catalog Info window

provides summary information about the entire catalog. The Pasteboard

window is a temporary work space that you can use as a staging area for

items collected from different searches.

• For information on setting startup options, see “Setting preferences.”

• For more information about the Catalog Info window, see “Viewing

item or catalog information.”

• For more information about the Pasteboard window, see “Using the

Pasteboard window.”

Note: Whenever the pointer appears followed by two periods, like this  ,

you can double-click to open a dialog box or another window that is rel-

evant to the element you are currently pointing to.

Shortcuts

Open a catalog

(“Open…” on File menu)

Command + O

Open Find window

(“Find…” on Search menu)

Command + F

Open Gallery window

(“Gallery” on Window menu)

Command + R

Open Pasteboard window

(“Pasteboard” on Window menu)

Command + B

Change Gallery (or Pasteboard)

from Text List to Thumbnail view

(“Thumbnails” on View menu)

Command + T or

Double-click right end of

information bar

Change Gallery (or Pasteboard)

from Thumbnail to Text List view

(“Text List” on View menu)

Command + L or

Double-click right end of

information bar
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Searching through a catalog

Use the Find window to tell Aldus Fetch which catalog items you want

to see. You will probably find that you use different search strategies at

different times. For example:

• If your catalog is small or you’re looking for ideas, you might start by

looking through everything the catalog contains.

• If your catalog is very large or you have a general idea of what you’re

looking for, you might want to look only at items related to a particu-

lar subject or concept, or of a particular file type.

• If you’re in the final stages of a job, you probably know exactly what

items you need.

Fetch displays the results of the search in the Gallery window. Items

from the most recent search completely replace the previous contents,

if␣any, of the Gallery window but leave the Pasteboard window intact.

Note that in the multiuser version of Fetch, up to 50 users can search the

same catalog simultaneously.

. To open the Find window (or bring it to the front if open):

Choose “Find…” from the Search menu.

Fetch opens the Find window and displays the description of the last

search carried out.

. To display the entire contents of the catalog:

Click “Find All” in the Find window.

(Click “Clear” to change the “Find” button to “Find All” if necessary.)

. To retrieve a particular set of items from the catalog:

Use the Find window as shown on the following page to describe what

you are looking for, then click “Find.”

Fetch lets you search for items by keyword, filename, file type, or vol-

ume. When you search by keyword or filename, you can specify text

to match, contain, start with, or end with. When you search by file type

or volume, you choose from a menu of the file types or volumes refer-

enced in the catalog and in the user’s preferences.

Shortcuts

Open Find window or bring it to the

front if already open

(“Find…” on Search menu)

Command + F

Expand Find window

(“More Choices” button)

Command + M

Reduce Find window

(“Fewer Choices” button)

Command + F

Open Find window, then clear exist-

ing search

(“Clear” button)

Command + Delete

Open Find window, then display

entire catalog

(“Find All” on Search menu)

Command + ' (apostrophe)

Open Find window, then carry out

default search

(“Default” on Search menu)

Command + D

Repeat previous search

(“Previous” on Search menu)

Command + , (comma)

Save or edit a named search

(“Define…” on Search menu)

Command + K
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Using Catalogs 17

Use the small Find window for a simple search

In the small version of the window, you
can enter a single search description.

A Check this box to make a search
description active.

B Choose an attribute: filename, key-
word, file type, or volume. (The volume
need not be mounted before a search.
A mounted volume is a storage device
recognized by the system and is avail-
able for reading and/or writing infor-
mation to.)

C Modify the chosen attribute:
“matches,” “starts with,” “contains,”
or “ends with” for a keyword or
filename search; otherwise, choose a
file type or volume name.

D For a keyword or filename search, type
a word or part of a word here.

E Click here to expand Find window to
its larger form (shown below).

F Click here to clear and uncheck the
search description.

G Click here to start the search. Button
name is “Find All” if no description is
checked. Otherwise, it’s “Find.”

Find window containing multiple active search descriptions

b

c

Use the expanded Find window for a more complex search

In the expanded Find window, you can
give Fetch as many as four search de-
scriptions to combine in a single search.
Click “More Choices…” in the small Find
window to display this larger version of
the window.

A Check each box in turn to start another
search description.

B Choose “and” to narrow the search,
“or” to broaden it.

C Click here to reduce Find window to its
smaller form.

Find window containing an active search description

Find window when clear

a

a

a

b d

e f g

c
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Streamlining your searches

Aldus Fetch has several options that can help you search through a cata-

log quickly and effectively. For example, you can:

• Choose the most efficient searches for Fetch to carry out.

• Name and save frequently used searches (to save yourself from

having to re-enter the descriptions each time).

• Customize the default search that Fetch carries out whenever you

open a catalog or choose “Default” from the Search menu.

Searching more efficiently

When you search on “Keyword” or “File Name,” choose “matches”

from the modifier popup menu for the fastest searches, or “starts with”

for searches that are nearly as fast. These searches are always faster

(more efficient) because Fetch uses indexes built into the database.

Other types of searches may be a little slower because Fetch must exam-

ine every entry in the database:

• Searching on file type or volume is slower when there is a large num-

ber of items that match what you are looking for.

• Searching on keyword or filename using “contains” or “ends with”

can be slower when the catalog is large.

Volumes referenced in the catalog need not be mounted before you

search.

Saving search definitions

If you routinely use a particular set of items in a catalog, you can name

and save a search definition that retrieves those items.

Your named searches appear on the Search menu below the predefined

searches “All,” “Default,” and “Previous.” Whenever you want to carry

one out, choose its name from the Search menu. You can save up to 29

defined searches.

Note: In a multiuser environment, each user can create up to 29 personal

search definitions that are not visible to other users.

Shortcuts

Open “Definitions” dialog box

(“Define…” on Search menu)

Command + K

Carry out default search

(“Default” on Search menu)

Command + D

Open “New Definition” dialog box

(“New” button in “Definitions”

dialog box)

Command + N

Delete a definition

(“Delete” button in “Definitions”

dialog box)

Command + D

Rename a definition

(“Rename” button in “Definitions”

dialog box)

Command + R

Open “Edit Definition” dialog box

(“Edit” button in “Definitions”

dialog box)

Return

Close the “Definitions” dialog box

(“Done” button in “Definitions”

dialog box)

Command + Return
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. To define and save a search:

1. Choose “Define…” from the Search menu.

2. In the “Definitions” dialog box, click “New.”

3. In the “New Definition” dialog box:

• Type a name for the new definition, then enter one or more search

descriptions just as you would in the Find window. The dialog box

initially contains the descriptions from the current contents of the

Find window.

• Check “Find Automatically” if you want Fetch to carry out the

search automatically when you choose its name from the Search

menu. Leave this option unchecked if you want Fetch to simply

open the Find window and display the search description.

4. Click “OK” to return to the “Definitions” dialog box, then click

“Done” to close the dialog box and save the search definition.

Fetch stores the search definition you just created in its Preferences

file. You can share your search definitions with other users by provid-

ing them with a copy of this file. You will find the Aldus Fetch™

Prefs file in the Aldus Fetch™ Preferences folder in the Preferences

folder of the System folder (if you are running System 7) or just loose

in the System folder (if you are running System 6.0.7 or 6.0.8).

You can also use the “Define…” command to rename or to remove

search definitions from the list, or to edit any of the searches.

Using the default search

You can use the “Define…” command to edit the default search defini-

tion so that it retrieves the items you use most often. Fetch carries out the

default search the first time you open a catalog after starting the program

or whenever you choose “Default” from the Search menu. Change the

definition as often as you wish to reflect your current needs. You can

edit the default search, but not rename or delete it.

For more information about setting a default catalog or project, see “Set-

ting preferences.”

Searches on names without an ellipsis are carried
out automatically. Searches on names with an ellip-
sis open the Find window and display the search
description.
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Thumbnail view shows a small thumbnail
image and minimal text information for
each item in the window. Resize the win-
dow to see more or fewer thumbnails at
once. Scroll to see thumbnails not cur-
rently visible.

A Displays the name of the open catalog.

B Displays the number of items found
from the latest search. Double-click
here to open the Catalog Info window.

C Displays the status of the latest
search. Double-click here to open the
Find window.

D Press Option + click here to make the
window fill the screen.

E Double-click here to change to Text
List view.

Viewing search results

Aldus Fetch displays the results of a search in the Gallery window. You

can see the Gallery window in Thumbnail view (for visual browsing) or

Text List view (for more information). In either view, you can scroll and

select items to preview, print, edit, or use in other documents.

Thumbnail view

b

a c

d

e
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Working in Thumbnail view

To do this… Follow this procedure…

Reorder all items in the window Choose one of the “by” commands from the View menu. The “by” commands allow

you to reorder the items by the order they were entered into the catalog, filename,

file type, volume, or folder.

Select an item Click its thumbnail. Or click the text below the thumbnail. To add another item to the

selection, press Command + click the thumbnail. To select all items between the

last and current item, press Shift + click the thumbnail.

Preview an item Double-click the thumbnail. Or select the item, then press Return or choose “Pre-

view” from the Item menu (Command + J). For faster scrolling and zooming of still

images with G-World, hold down the G key while previewing.

Display an item’s information window Double-click the text below the thumbnail. Or select the item, then choose “Get

Info” from the Item menu (Command + I).

Edit an item’s source file Press Option + double-click the thumbnail. Or select the item, then choose “Edit

Original” from the Item menu (Command + G). To edit the source file in an applica-

tion other than the one last associated with its file type and creator, press Option +

Command + G.

Copy the item into another document Select the item, then choose “Copy” from the Edit menu (Command + C). The

selected item is stored on the Clipboard and is available for pasting into another

document. If the item is very large and your RAM is limited, you may not be able to

copy the item onto the Clipboard.
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Text List view shows a list box in the top
half of the window and the thumbnail,
keyword list, and description of the
selected item in the bottom half. Scroll
the list box to see items not currently
visible.

A Displays the name of the open catalog.

B Double-click here to open the Catalog
Info window.

C Double-click here to open the Find
window.

D Press Option + click here to make the
window fill the screen.

E Double-click here to switch to Thumb-
nail view.

Text List view

b

a c

e

d
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Working in Text List view

To do this… Follow this procedure…

Reorder all items in the window Click a column heading. Or choose one of the “by” commands from the View menu.

The default is the order in which the items were added to the catalog. Note: Gallery

list reverts to view by order after each search.

Select an item Click its row in the list box. To add another item to the selection, press Command +

click the row. To select all items between the last and current item, press Shift +

click the row.

Preview an item Select the item; then press Return, double-click the thumbnail, or choose “Preview”

from the Item menu (Command + J). For faster scrolling and zooming of still images

with G-World, hold down the G key while previewing.

Display an item’s information window Double-click a row in the list box. Or select the item, then choose “Get Info” from

the Item menu (Command + I).

Edit an item’s source file Select the item; then press Option + double-click the thumbnail or choose “Edit

Original” from the Item menu (Command + G). To edit the source file in an applica-

tion other than the one last used for similar files, press Option + Command + G.

Edit an item’s keyword list Select the item, then double-click the word “Keywords” (Command + Y).

Edit an item’s description Select the item, then double-click the word “Description” (Command + U).

Copy item's source file onto the Clipboard Select the item, then choose “Copy” from the Edit menu (Command + C). See also

“Using an item in another document.”
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Previewing an item

If you would like to look more closely at any image or play sound or

movie items, open a Preview window. You can have as many Preview

windows as you want open at once.

The names of all open Preview windows appear on the Window menu

together with the names of any open Info windows.

Before displaying an item in a Preview window, Aldus Fetch must be

able to locate the item’s source file—that is, the original file from which

the catalog entry was made. Fetch alerts you when a source file cannot

be located.

Note: In order to play movies and sounds, you must have the QuickTime

extension installed in your System folder, and your Apple Macintosh

must be running System 6.0.7 or later. QuickTime is installed automati-

cally when you install Fetch.

. To preview an item:

Select the item, then press Return.

or

Double-click its thumbnail in the Gallery, Pasteboard, or Info window.

or

Select the item, then choose “Preview” from the Item menu

(Command + J).

For faster scrolling and zooming of still images with G-World, open the

Preview window while pressing the G key.

Note: Some file types cannot be previewed. Among these are applica-

tions and Fetch catalogs and projects. For a complete listing of file types

recognized by Fetch and whether or not they can be previewed, refer to

“Adding a file type.”

The Preview window lets you display and manipulate an item in various

ways depending on the item’s type (image, sound, movie), as described

on the following pages.

QuickTimeTM icon

Shortcuts

Open a Preview window

(“Preview” on Item menu)

Command + J or

Double-click thumbnail or

Select item, then press Return

Close active Preview window

(“Close” on File menu)

Command + W or

Click close box

Close all active Preview

and Info windows

Option + click close box

Return to Gallery window

(“Gallery” on Window menu)

Command + R or

Double-click image

Return to Pasteboard window

(“Pasteboard” on Window menu)

Command + B
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a

b

c

d

e

Previewing sounds

A sound item in the Preview window
appears and works much the same as a
movie item, except that there is no visual
component. The QuickTime control bar
lets you start, stop, and step through a
sound item; select part of the sound item;
and control the volume.

A Filename of the sound in the window

B File type

C Sound drop-down menu

D Sound duration

E QuickTime control bar

All of the Preview window shortcuts and
procedures for movies also work for
sounds.

Previewing KODAK Photo CD images

A KODAK Photo CD image is a still image
file saved in a format compatible with
KODAK’s Photo CD imaging software and
hardware.

The Preview window for a KODAK Photo
CD image is the same as the Preview
window for other types of still images,
with the addition of a drop-down menu
that lets you display the image at different
resolutions and rotate or flip the image. If
you have selected a part of the image,
choosing a command from this menu
opens a new Preview window.

Otherwise, all of the shortcuts and proce-
dures for working with a still image (de-
scribed in the following pages) also work
for KODAK Photo CD images.
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c

d

g

f

b

a

e

Previewing still images

A still image initially appears in a Preview
window either at actual size (100% mag-
nification) or scaled to fit a window appro-
priate to your screen size, depending on
your preference settings.

A File name of the item in the window

B File type

C Image size using the unit of measure
specified as the preference

D Current magnification

E Preview window cursor

F Partial-image selection area

G Resize box
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Working with a still image in a Preview window

To do this… Follow this procedure…

Select a portion of the image Drag a box around the area.

Select the whole image Choose “Select All” from the Edit menu (Command + A).

Increase magnification in the window Press Shift + click image.

Decrease magnification in the window Press Option + click image.

Return image to actual size Press Shift + Option + click image.

Increase both magnification Choose “Zoom In” from the View menu (Command + + (plus sign)).

and window size

Decrease both magnification Choose “Zoom Out” from the View menu (Command + - (hyphen or minus sign)).

and window size

Return image to actual size (100%) and Choose “Actual Size” from View menu (Command + ` (accent)).

adjust window size to fit

Edit the image’s source file Select the item; then press Option + double-click the thumbnail or choose “Edit

Original” from the Item menu (Command + G). To edit the source file in an applica-

tion other than the one last used for similar files, press Option + Command + G.

Copy the image to the Pasteboard window Choose “Copy to Pasteboard” from the Item menu (Command + M).

Copy the image to the Clipboard Choose “Copy” from the Edit menu (Command + C). See also “Using an item in

another document.”

Open the item’s information window Choose “Get Info” from the Item menu (Command + I). Or double-click the

information bar (above the image).
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A movie item appears in the Preview
window at its actual size with a standard
QuickTime control bar that lets you start,
stop, and step through the movie; select
frames; and control the volume. You
cannot resize a movie preview.

A Filename of the movie in the window

B File type (MooV)

C Movie drop-down menu

D Movie duration

E Badge (if control bar is not present)

F QuickTime control bar

G Volume control

H Play button

I Play bar

J Step buttons

ca

b

d

i jhge

f

Previewing movies
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Working with a movie in a Preview window

To do this… Follow this procedure…

Select part of the movie Press Shift + drag within the play bar (selected frames appear highlighted).

Play or pause the movie Click the play button. Or press the spacebar. Or double-click the movie to play, click

to pause.

Control playback speed Press Control + click either of the step buttons.

Step forward or backward one frame Click the forward or backward step button, or press the right or left arrow key.

Jump to first or last frame Press Home or End.

Increase or decrease volume Click the volume control and adjust the slider. Or use the up and down arrow keys.

Show or hide the play bar Press Tab.

Edit the movie’s source file Choose “Edit Original” from the Item menu (Command + G). To edit the movie in an

application other than the one last associated with its file type and creator, press

Option + choose “Edit Original…” (Option + Command + G).

Copy the movie to the Pasteboard window Choose “Copy to Pasteboard” from the Item menu (Command + M).

Copy the movie to the Clipboard Choose “Copy” from the Edit menu (Command + C). See also "Using an item in

another document."

Open the movie’s information window Choose “Get Info” from the Item menu (Command + I).
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Working with an item’s source file

Once you have identified a catalog item you want, you can work with it

from within the open catalog. For example, you can:

• Switch to another program to edit the source file (the original file to

which the catalog entry points).

• Move, copy, or delete the source file.

• Copy the item to the Clipboard, switch to another program, and then

paste the item in a document.

• Copy a reference (or pointer) to the Clipboard or send a reference

directly to a supporting application.

• Find out more information about the item.

• Print or fax thumbnails or the item itself.

Important: In a multiuser setting, be careful about moving or deleting

source files unless you are sure that the entire workgroup wants the files

moved or deleted.

. To edit an item’s source file:

1. Select the item in the Gallery or Pasteboard window.

Or open a Preview or Info window that contains it.

2. Choose “Edit Original” from the Item menu.

Aldus Fetch remembers the name and location of the application last

used to edit the source file for any item of the same type and creator. If

necessary, you will be prompted to choose an application and to

specify where the application is located.

Fetch opens the application, which in turn opens the source file for

editing.

Note: When using the “Edit Original” command with a catalog or

project, Fetch will try to open the catalog or project using the version

of Fetch currently running. If the catalog or project is incompatible

with this version of Fetch, you will be able to select the appropriate

version from the “Edit Original” dialog box.

3. Make the changes you want, save the file, and quit the application.

After quitting the editing application, you are returned immediately to

Fetch.

Tip

To edit the source file in an applica-

tion other than the one that Fetch

last associated with a particular file

type and creator, press Option while

choosing “Edit Original…” from the

Item menu. The new application

becomes the one that Fetch will

remember until you change it again.
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4. Choose “Update Now” from the Admin menu to update the item’s

thumbnail in the catalog.

Otherwise, the next time that you print, preview, edit, move, or copy

the item, you will be prompted to update it.

. To copy or move a source file:

1. Select the item in the Gallery or Pasteboard window.

2. Choose “Copy Original…” or “Move Original…” from the Item

menu.

3. In the file directory dialog box, locate and open the folder where you

want the copy or the original to go.

4. Click “Folder.” Fetch will then move or copy the source file into the

opened folder.

Note: “Copy Original…” makes a copy of the source file, keeping

the␣link between the catalog item and the original copy only. “Move

Original…” moves the source file from its current location to the one

you specify. If the source file is locked, “Move Original…” will not

move the file, but will instead make a copy of it and move it to the new

location.

Fetch does not automatically update the catalog after you move a file.

Instead, you must select the item and choose “Update Now” from the

Admin menu, or respond to the update prompt the next time you try to

print, preview, edit, or get information about the item.
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. To delete a source file:

1. Select the item in the Gallery or Pasteboard window.

2. Choose “Delete Original…” from the Item menu.

Be very careful about using the “Delete Original…” command to

delete source files. Files deleted in this way do not go into the Trash.

Once you confirm the deletion within Fetch, the files are deleted

immediately and cannot be recovered.

3. Click “Cancel” if you change your mind or “OK” to go ahead and

delete the file.

Important: Deleting the source file does not delete the item from the

catalog. You can, for example, scan a series of photographs, catalog

the scanned images, then delete the original files. You’ll still have

the␣catalog entries as a way of keeping track of the original photo-

graphs. If you do decide to delete the catalog entries as well, use the

“Delete…” command on the Admin menu, or select the item and

press␣Delete.

You can also use the “Purge…” command on the Admin menu to

check whether or not Fetch can still locate the source file for a catalog

item, then delete the item if you want. For more information about

deleting and purging items, see “Maintaining a catalog.”
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Using an item in another document

Fetch lets you use the cataloged source files in other publications or pre-

sentations. For example, you might include a SuperPaint illustration in a

PageMaker publication or import a QuickTime movie into a Persuasion

presentation. Fetch lets you copy any such source file (or part of it) to the

Clipboard and then, in the receiving application, paste it in the document

you want.

For an increasing number of applications that are Fetch-aware, Fetch

also provides a way to copy or send a reference only, so that the other

document receives a reference, or pointer, to the original file rather than

the entire file.

Fetch-awareness can vary from supporting a special Clipboard format

for copying and pasting a reference to supporting the “Place” Apple

Event. For information on how to use the different transfer methods, see

the procedures described below. For information on the latest list of

Fetch-aware applications, see the ReadMe file. For details of how your

application supports Fetch, contact the application’s manufacturer.

Transferring Aldus Fetch catalog items to other documents

If the receiving application… Use this command… To transfer…

Is Fetch-aware or not Copy A single item or the selected part of an item to

another application on the computer you are using.

Supports FETCH Clipboard format Copy Reference One or more whole items, with either text (pathname

to original file) or thumbnails, to another application

on the computer you are using.

Supports “Place” Apple Event Send Reference… One or more whole items to any computer on the

network.
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Transferring a file

Copying an item from Fetch and pasting it in your page layout or other

application uses the Macintosh Clipboard and copies the entire source

file (or selected part thereof) into the receiving application. You can use

this method to transfer any catalog item to any appropriate application,

whether it is Fetch-aware or not. The receiving document increases in

size by the size of the original file or of the selected portion of the file.

You can always copy all or part of an item. Its format, however, may

change when placed in the Clipboard. The format change depends on the

item’s original file type:

• Copying a still image (such as EPSF, TIFF, DCS) to the Clipboard

changes it to a PICT format. Of particular note are EPSF images. If

you copy an entire EPSF image, Fetch places PostScript information

in the resulting PICT. If you copy only part of the EPSF image, the

resulting PICT will lack the PostScript information and not print

correctly.

If you need to preserve the image’s original format, you must manu-

ally import the image into the application.

• Copying a movie, in all or in part, copies only the movie reference,

not the actual frames.

• Copying a sound changes it to the SND format.

. To transfer an item or part of an item using “Copy”:

1. In Fetch, select an item. Or open a Preview window that contains an

item and select the part of the item you want.

2. Choose “Copy” from the Edit menu.

3. In the receiving application, choose “Paste” from the Edit menu.
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Transferring a reference

Copying or sending a reference is preferable to copying and pasting a

file because the receiving document has the option of storing only the

reference rather than the entire file. Storing only a reference minimizes

the size increase of the receiving document.

How you place an item in the receiving document depends upon the

application you are using. Some Fetch-aware applications require you

to␣paste the reference into the document; others provide a palette or other

mechanism for selecting and placing the item. For details, refer to the

documentation provided by the application’s manufacturer.

. To transfer one or more items using “Copy Reference”:

1. In Fetch, select one or more items.

2. Choose “Copy Reference” from the Edit menu, then choose “Include

Text” or “Include Thumbnails” from the submenu.

Include the text when the receiving application does not accept thumb-

nails. Include the thumbnail when the receiving application does

accept thumbnails.

3. In the receiving application, place the item according to procedures

described in the application’s own documentation.

Note: You can copy no more than 125 items at a time. If you have more

than 125 items selected when you choose “Copy Reference,” Fetch dis-

plays a message asking you to select fewer items and to retry the Copy

command.

. To transfer one or more items using “Send Reference…”:

1. In Fetch, select one or more items.

2. Choose “Send Reference…” from the Item menu.

3. In the dialog box, identify and locate the receiving application.

The application can be on your own computer or on another Macin-

tosh on the network.

4. In the receiving application, place the item according to procedures

described in the application’s own documentation.
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Viewing item or catalog information

When you want to know more about an individual item than Aldus Fetch

displays in either Thumbnail or Text List view, select the item and open

an Info window. You can have as many Info windows open as you want.

A separate Catalog Info window provides additional detail about the

catalog as a whole.

The Catalog Info window

The Catalog Info window provides
detailed information about the number of
items in the catalog, the size of the cata-
log, modification dates, all keywords
used, and all volumes on which any cata-
log items reside.

A Displays catalog name.

B Displays information about the
catalog’s filename, size, and location.

C Displays information about the catalog,
including the name of the person who
last set the password if any.

D Displays master keyword list.

E Displays a list of all volumes refer-
enced by the catalog, with unmounted
volumes in italics.

b

c

ed

a
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Working in the Catalog Info window

To do this… Follow this procedure…

Open the Catalog Info window Choose “Catalog Info…” from the File menu. Or double-click the left end of the

information bar in the Gallery or Pasteboard window.

Retrieve all items that use a keyword Double-click that keyword in the “Keywords” list box.

Refresh the keyword list Double-click the word “Keywords.”

Refresh the volume list Double-click the word “Volumes.”

Toggle the keyword list order Press Option + click “Keywords” to toggle the order temporarily between alphabeti-

cal and frequency-of-use.

An Info window displays detailed informa-
tion about an item, including its filename,
type, size, creation and modification
dates, pathname, keywords, and descrip-
tion. Fetch lists open Info windows on the
Window menu.

A Displays the item’s filename.

B Displays information about the item’s
source file. Size, creator, and creation
and modification dates are taken from
information in the source file. If the
source file is not available, this infor-
mation appears as “N/A” in the “File
Info” field.

C Displays information about the item’s
entry in the Fetch catalog.

D Click here to see more information in
either of these fields.

E Displays the item’s description.

F Displays the item’s keyword list.

G Displays the item’s thumbnail.

The Info window

a

b

d
c

f ge
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Working in the Info window

To do this… Follow this procedure…

Open an Info window In Thumbnail view of the Gallery or Pasteboard window, double-click the text below

the thumbnail. Or select one or more items, then choose “Get Info…” from the Item

menu (Command + I ). In Text List view, double-click an item in the list. Or select

one or more items, then choose “Get Info….” In a Preview window, double-click the

center of the information bar. Or choose “Get Info…” from the Item menu.

Edit the description Double-click the word “Description.” Or choose “Description…” from the Edit menu

(Command + U).

Edit the keyword list Double-click the word “Keywords.” Or choose “Keywords…” from the Edit menu

(Command + Y).

Retrieve all items that use a keyword Double-click that keyword in the list.

Toggle the keyword list order Press Option + click “Keywords” to toggle the order temporarily between alphabeti-

cal and frequency-of-use. To change the default order, use the “Preferences…”

command on the Edit menu.

Preview the item Double-click the thumbnail. Or choose “Preview” from the Item menu (Command +

J). For faster scrolling and zooming of still images with G-World, hold down the G

key while previewing.

Edit the source file Press Option + double-click thumbnail. Or choose “Edit Original” from the Item

menu (Command + G). To edit the source file using an application other than the

one that Fetch last associated with the item’s file type and creator, press Option +

Command + G.
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Setting preferences

The rest of Chapter 2 describes a number of features that let you custom-

ize Fetch to suit your working style and help you work more produc-

tively:

• Set workstation preferences using the “Preferences…” command

from the Edit menu.

• Share preferences with other users.

• Use the Pasteboard window as a temporary staging area for items

found from multiple searches.

• Create a project file that contains a set of items to which you want

quick access or that you want to send to another Fetch user.

• Use the “Print…” command to print thumbnails or full-size images

from within Fetch, or to send thumbnails or images via fax modem to

another user.

. To set or change preferences:

1. Choose “Preferences…” from the Edit menu.

Note: If the Fetch Preferences file has been locked using the Finder’s

“Get Info” dialog box, Fetch will display a message stating this before

displaying the “Preferences”␣dialog box. You can make changes in the

“Preferences” dialog box when the Fetch Preferences file is locked;

however, Fetch will not save those changes when you click “OK.”

2. Choose the options you want, then click “OK.”

Tip

Two other helpful options include

setting a default catalog or project

and customizing the default search.

To set a default catalog or project,

use the “Default Document…” com-

mand on the File menu or the “Save

as Default Document” check box in

the “Open,” “Open Project,” “New,”

and “Save As Project” dialog boxes.

The default catalog is the one that

Fetch opens automatically when you

double-click the Fetch application

icon or to which it adds new items

when you select and drag one or

more document icons over the Fetch

icon when Fetch is not running

(System 7 only).

To edit the default search, use the

“Define…” command on the Search

menu. The default search is the one

that is carried out automatically the

first time that you open a catalog

after starting the program or when

you choose “Default” (Command +

D) from the Search menu. For infor-

mation about using the “Define…”

command, see “Streamlining your

searches.”
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�Setting preferences in Aldus Fetch

Option Choices Description

Default Window Find… Makes Find window active when you open a catalog; displays the default

search in the Find window.

Gallery (Text List) Makes Gallery window active when you open a catalog; performs a “Find

All” search; displays result of search in Gallery window in Text List view.

Gallery (Thumbnail) Makes Gallery window active when you open a catalog; performs a “Find

All” search; displays result of search in Gallery window in Thumbnail view.

On Startup None Double-clicking the application icon starts the program.

Open Document Double-clicking the application icon starts the program, then opens the file

directory dialog box where you can choose a catalog or project to open. To

start Fetch using this option at any time, press Option + double-click the

application icon.

Default Document Double-clicking the application icon starts the program and opens the

catalog or project identified as the default.

Sort Keywords By Name Sorts item keyword lists alphabetically.

By Occurrences Sorts item keyword lists by frequency-of-use. To toggle the order

temporarily, press Option + click “Keywords” below the keyword list box.

Preview Window Full Size Displays previews at full size (100% magnification).

Scaled to Fit Displays previews at a magnification that Fetch chooses based on the size

of your monitor.

Dimensions Sets the default measurement system for displaying dimensions (inches,

points, picas, centimeters, or millimeters).

Skip Add/Update Dialog When checked, does not display the “Add/Update Options” dialog box when

you choose “Add/Update Items…” from the Admin menu. Press Option +

choose “Add/Update Options…” to toggle the default temporarily.

Dither Previews Requires Color QuickDraw. When checked, attempts to improve the display

of color and grayscale images when viewed at a lower bit depth than the

original image (for example, on a monochrome monitor). Using this option

requires more memory and may result in slower drawing of previewed im-

ages. To turn on dithering, hold down Shift key while previewing; to turn off,

hold down Command key while previewing.

Play Movies at Preview When checked, movie items play automatically when previewed.

Play Sounds at Preview When checked, sound items play automatically when previewed.

Show Badge in Movie When checked, movies appear in Preview windows with a badge rather than

a control bar. Click the badge or press Tab to display the control bar when

you want it.
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Using the Pasteboard window

The Pasteboard window is a place where you can temporarily store items

while a catalog is open. For example, you might select items displayed in

the Gallery window as the result of a series of searches, copy them to the

Pasteboard window, and then do any of the following:

• Select items in the Pasteboard window, then choose “Preview” from

the Item menu to compare the items and pick the one you really want.

For information about previewing, see “Previewing an item.”

• Select items, choose “Export…” from the Admin menu to export the

items, and then import them into a new or another catalog. For more

information, see “Maintaining a catalog.”

• Select items, then copy and paste them into another document or

copy␣or send references to the items as described in “Using an item

in␣another document.”

• Choose “Print…” from the File menu to print the set of thumbnails.

For more information, see “Printing catalog items.”

The Pasteboard window functions like the Clipboard but is able to hold

more than one item at a time. Fetch clears the Pasteboard window when

you close the catalog. You can display the Pasteboard window, like the

Gallery window, in Thumbnail view or Text List view. All of the proce-

dures and shortcuts (except for searching) used in the Gallery window

also work in the Pasteboard window. For details, see “Viewing search

results.”

The Pasteboard window in Thumbnail view

The Pasteboard window in Text List view
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. To copy an item to the Pasteboard:

Select one or more items in the Gallery window, then choose “Copy

To Pasteboard” from the Item menu.

or

Press Control + click the item’s thumbnail in the Gallery window, Info

window, or List view.

By selecting and copying items one at a time, you can ensure that the

items appear in the Pasteboard window in exactly the order you want.

If you select multiple items to copy, they will appear in the Pasteboard

in the order they appear in the Gallery window.

. To see the contents of the Pasteboard window:

Choose “Pasteboard” from the Window menu.

. To clear an item from the Pasteboard window:

Select the item, then choose “Clear” from the Edit menu.

Shortcuts

Open Pasteboard window

(“Pasteboard” on Window menu)

Command + B

Copy selected item to

Pasteboard window

(“Copy To Pasteboard” on Item

menu)

Command + M or

Press Control + click thumbnail

Clear selected item from

Pasteboard window

(“Clear” on Edit menu)

Clear

05/UG_ch2again.pm5 1/31/94, 1:11 PM42



Using Catalogs 43

Creating a “project” in Aldus Fetch

An Aldus Fetch project is a collection of references to items from a

single catalog that you save as a separate file. Use a project for work in

progress or to give or send items to another user. Because a project file

includes only references or pointers to items in the original catalog, it is

small in size and can easily be mailed to a user electronically or copied

to a floppy disk.

Consider these scenarios and imagine how project files could help you:

• An editor uses a project file to send images to a designer or produc-

tion artist for the final layout of an article.

• At a newspaper, a photo editor regularly catalogs newly scanned pho-

tos, then circulates a daily or weekly project file that contains only the

most recent photos for editors to review.

• A production artist who is completing a monthly newsletter creates a

project file that contains all the necessary artwork. Without having to

search for all the images in a catalog, the artist merely opens the

newsletter project.

. To create a project:

1. In either the Gallery or Pasteboard window, select the items you want.

2. Choose “Save As Project…” from the Item menu.

3. In the file directory dialog box, enter a name, then click “OK.”

Aldus Fetch project icon
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. To open and use a project:

Regardless of whether Fetch is currently running, you can either:

• Double-click the project icon in the Finder.

• Or drag the project icon over the Fetch application icon.

If Fetch is running and:

• A catalog is open, choose “Open Project…” from the File menu,

then select the project.

• No catalog is open, choose “Open…” from the File menu, then

select the project.

Fetch must be able to locate the catalog when you or another user open a

project created from it. When you open the project, Fetch opens the cata-

log from which the project items were saved, then opens the Pasteboard

window and copies the project items to it. If the catalog was already

open, Fetch adds the project items to any items already in the Pasteboard

window.

To make projects even easier to use, you can create an alias (System 7

only) for a frequently used project, and place that alias in your Apple

Menu Items folder (in your System folder). Your project will then

appear in the Apple Menu. Selecting the project from the menu will

launch Fetch (if it’s not running already) and open the project.

7
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Printing catalog items

Although you will typically find and select a catalog item either to edit

the source file or use it in another document, you might want to print

from the catalog itself—to show a client, for example, or to evaluate

items for possible use in a document.

When you choose “Print…” from the File menu, Aldus Fetch prints the

contents of the active window. Thus, to print thumbnails, print from the

Gallery or Pasteboard window. To print a single full-size image, print

from a Preview window. If you have a fax modem installed in your com-

puter, you can also use the “Print…” command to fax thumbnails or im-

ages to another person. Use the Chooser to specify the output device that

you want.

When you choose the “Print…” command, the resulting dialog box

reflects what you have in the active window:

• If the active window is a Preview window, what you see is the stan-

dard Macintosh “Print” dialog box that contains no special options

for Fetch.

• If the active window is the Gallery or Pasteboard window, the bottom

half of the dialog box contains the options described in the table

below.

Options for printing thumbnails

Print Option Choices Description

Print Using… Actual Images Prints thumbnails using the original source files if available. This

option generally yields a higher-quality output, but can be time

consuming because Fetch must open and process each item’s

source file when creating its thumbnail. Thumbnails in the cata-

log are substituted for any actual images that are not found.

Thumbnails in Always prints from the thumbnail images available in the

Catalog catalog.

Quality Best (slowest) Provides the highest-quality output and the slowest print times.

Better Provides medium-quality output at moderate print times.

Good (faster) Provides the lowest-quality output but the fastest print times.

Larger Thumbnails When checked, prints thumbnails that are twice the normal

height and width (four times the area of a regular thumbnail).

Number pages from Unless you enter a number for the first page of your output,

Fetch starts with page 1 or with the number specified at the

beginning of the dialog box.
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Troubleshooting printing problems

Make sure that you are using LaserWriter driver 6.0 or later. To find out

which version you are using, select the LaserWriter file in the Exten-

sions folder of the System folder and choose “Get Info” from the File

menu. (If you are using System 6.0.7 or 6.0.8, the LaserWriter file can be

found in the System folder.)

If using the “Actual Images” option causes problems, it may be that your

printer is having trouble handling the amount of information needed to

print the page. Try making these adjustments to correct the problem:

• Print using the “Black & White” option in the “Print” dialog box.

This allows the printer to print all colored areas as black or white,

depending on the darkness of the area. This option usually decreases

the quality of the printed image, but may require less printer memory.

• Print using the “Larger Thumbnails”␣option. This reduces the number

of thumbnails per page.

• Print using the “Better” or “Good” option. This helps limit the

amount of information needed to print each thumbnail.

• Turn background printing off in the Chooser. This frees the printing

process from having to compete with other applications for memory.

• Allocate more memory to the PrintMonitor or install more RAM

in␣the printer. This increases the amount of memory available for

printing.

• Allocate more memory to Fetch. This lets Fetch use more memory to

prepare the image for printing.

• Try using the appropriate System 7 printer driver. The newest printer

drivers are redesigned to handle large images more gracefully.

If you do not get the results you want when printing from the Preview

window using the “Black & White” option, try printing using the

“Color/Grayscale” option instead. This results in the printer using black

dots to approximate the darkness of colored or gray areas in the image.

While the “Color/Grayscale” option may increase the quality of your

printed image, it may require more printer memory.

Most color images will print in color when sent to a color printer.

However, color images that require QuickTime to preview will not print

in color when your monitor is set to grayscale. To print these images in

color, either use a computer with a monitor set to color or use the Moni-

tors control panel to reset your monitor to color before printing the

image.
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Chapter 3
Creating and
Managing Catalogs

Chapter 3 describes how to create, maintain, and

modify Aldus Fetch catalogs; how to add and

modify keyword lists and item descriptions; and

how to control access to administrative functions

in a multiuser environment.

To carry out most of the procedures described in

this chapter, you must have full access to the

open catalog.
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Creating a new catalog from within Aldus Fetch

When you create a catalog using the “New…” command, Fetch prompts

for a catalog name, then opens the catalog and displays your default

startup window. The catalog is empty. To add items, follow the instruc-

tions in “Updating and adding items to a catalog.” Or import a previ-

ously exported catalog (or part of a catalog) as described in

“Maintaining a catalog.”

. To create a new catalog:

1. Start Fetch, then choose “New…” from the File menu.

If you already have a catalog open, the “New…” command is

dimmed. You must close the open catalog before you choose

“New…” because Fetch allows only one catalog to be open at a time.

2. In the file directory dialog box, specify a name and location for the

new catalog.

3. Check “Save as Default Document” if you want the new catalog to be

your default catalog.

The default catalog opens automatically on startup if you have it set to

do so in the Fetch preferences. Files are also added to the default cata-

log when you drag icons over the Fetch icon when Fetch is not running

(System 7).

Start Fetch, choose “New…” from the File menu as
described below, and then choose “Add/Update
Items…” from the Admin menu as described in
“Updating and adding items to a catalog.”

If no catalog is open and you do not have a default catalog, select the items you
want the catalog to contain, drag the icons onto the Fetch application icon until all
icons are highlighted, and then release.

7

Shortcuts

Create a new catalog

(“New…” on File menu)

Command + N

Save new catalog as default

(“Save as Default Document”

option in file directory dialog box)

Command + S

Add items to a catalog

(“Add/Update Items…” on

Admin menu)

Command + E

Creating a new catalog

You can create a new catalog in either of these two ways:
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7

4. Click “Save.”

Fetch creates the catalog, opens it, and then opens the Find window.

5. Add items to the catalog as described in “Updating and adding items

to a catalog.”

Creating a new catalog from the Finder

When you create a new catalog by dragging items over the Fetch icon,

the selection can include files, folders, or entire volumes in any combi-

nation. If no other catalog is open and you have not established a default

catalog, Fetch asks you to create a new catalog. Otherwise, the files you

drag over the Fetch icon are added to the default catalog (if there is one)

or to the open catalog.

. To create a new catalog from the Finder:

1. Start Fetch, then close any open catalog.

2. In the Finder, select the icons for the files, folders, or volumes that you

want in the catalog.

3. Drag the collection of icons over the Fetch icon; the Fetch icon is

highlighted. If the Fetch icon␣does␣not␣become␣highlighted, you may

need to rebuild your desktop. To do so, press and hold down Option +

Command while restarting your computer.

After you release the collection of icons, Fetch starts up and asks if

you want to create a new catalog or open an existing one.

4. Click “New.”

5. In the file directory dialog box, specify a name and location for the

new catalog. Check “Save as Default Document” if you want the new

catalog to be your default catalog, then click “Save.”

The default catalog opens automatically on startup if you have it set to

do so in the Fetch preferences. Files are also added to the default cata-

log when you drag icons over the Fetch icon when Fetch is not running

(System 7).

6. Review the settings in the “Add/Update Options” dialog box, change

any that you want, and then click “Continue….”

For more information on the options in this dialog box, see “Setting

catalog update options.”

7
Tip

To make the drag-and-

drop creation of new catalogs easier,

you can make an alias for Fetch and

place it on your desktop.
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Updating and adding items to a catalog

To ensure that a catalog contains the most recent versions of your files,

you should update the catalog after you’ve made changes to your files or

after you’ve moved or deleted files.

Start Fetch, open the catalog, and then
choose “Add/Update Items…” from the
Admin menu.

To add items to the default catalog, select
the␣files you want to add and drag them onto
the Fetch application icon when Fetch is not
running.

To add items to a catalog other than the
default, open the catalog, return to the
Finder, select the files, then drag them
onto the Fetch application icon.

77

Updating from within Aldus Fetch

When you add to or update a catalog using the “Add/Update Items…”

command, Fetch first displays the “Add/Update Options” dialog box,

then a file directory dialog box where you can select the files, folders, or

volume that you want to add to the open catalog.

. To add or update catalog items:

1. Start Fetch, open a catalog, and then choose “Add/Update Items…”

from the Admin menu.

2. Review the settings in the “Add/Update Options” dialog box, change

any that you want, and then click “Continue….”

3. In the file directory dialog box, locate the file, folder, or volume that

you want to add to the catalog.

The volume that contains the files you want to add must be mounted

(currently available) before you continue.

You can add or update catalog items in any of these three ways:

Tip

Fetch ships with a reasonable set of

default settings for cataloging most

files under most circumstances. You

can change these options at any

time, return to the original defaults,

or create your own. For more infor-

mation about these options, see

“Setting catalog update options.”

The “Add/Update Options” dialog

box appears only if the option “Skip

Add/Update Dialog” is unchecked in

the “Preferences” dialog box (use

the “Preferences…” command on

the Edit menu). By default, this op-

tion is unchecked, so that you will

continue to see the “Add/Update Op-

tions” dialog box each time until you

reset your preferences.
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If you choose to add items from an aliased folder, make sure that the

folder’s alias is no more than 27 characters long. Fetch treats folders as

if they were volumes and volume names in System 7 have a 27 charac-

ter limit. If the folder’s alias exceeds this limit, Fetch can crash when

trying to access the items within the folder.

To add… Follow this procedure…

A single file In the list box, select the file. Click “Open.”

All files in a folder or in Make sure that the name of the folder or volume you

a volume want appears above the list box. Click “Folder.”

All files and subfolders Make sure that the name of the folder or volume you

within a folder or volume want appears above the list box. Check “Include

Subfolders,” then click “Folder.”

A single file whose First add the application’s file type in the “File

file type is not listed Types”␣dialog box. Then use the “Add/Update

(an application) Options” dialog box to add the application.

When using the “Include Subfolders” option, make sure that the

subfolders are not aliased. Fetch ignores aliased subfolders and will

not add them to the catalog. To add an aliased subfolder to a catalog,

you must select and add it directly.

Fetch quickly scans the volume where the source files reside, displays

the “Modification Status” box, and then begins to examine each file in

turn before adding it to the catalog. Where a preview of the file is

available, Fetch shows the 8- or 32-bit version on the left and a 1-bit

version on the right.

When everything has been cataloged, Fetch displays an “Add/Update

Summary” message.

Important!

If Fetch crashes while trying to cata-

log a file that you suspect may be

damaged, try opening the file from

the application that created it (or an-

other application that can open that

particular file type). If the application

cannot open the file, do not try to

catalog the item in Fetch.

If you add the filename of the dam-

aged file to the exclusions list (see

“Excluding a file from adding or up-

dating”), Fetch will always ignore

the corrupt file in the future. This

will protect you from trying to add

the damaged file to other catalogs.

7
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4. Click “OK.”

Fetch returns you to the “Add/Update Options” dialog box, where you

can click “Continue…” again or “Done” to return to your catalog.

Updating by dragging in the Finder

When you add or update files by dragging them over the Fetch icon, the

selection can include files, folders, or volumes in any combination:

• If you have a default catalog and Fetch is not already running, Fetch

updates the default catalog.

• If a catalog is open, Fetch updates the open catalog.

. To update an open catalog from the Finder:

1. Select the icons for the files, folders, or volumes you want to add or

update.

If you want to add a Fetch catalog or project to a catalog, place the

catalog or project in a folder or volume and then select the icon for that

folder or volume. Do not select the actual catalog or project icon since

dragging one of these icons over the Fetch icon causes Fetch to open

the catalog or project instead of adding it.

2. Drag the collection of icons over the Fetch icon.

3. Review the settings in the “Add/Update Options” dialog box, change

any that you want to change, and then click “Continue….”

When updating is complete, Fetch displays the “Add/Update Sum-

mary” message.

4. Click “OK” to return to your catalog.
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. To update a closed catalog from the Finder:

1. Select the icons for the files, folders, or volumes you want to add or

update. While these items are still selected, select the catalog that you

want to add these items to.

2. Drag the selected icons over the Fetch icon.

3. Complete the update as if the catalog were open.

7
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Setting catalog update options

Unless you set your preferences otherwise, Aldus Fetch displays the

“Add/Update Options” dialog box whenever you:

• Choose “Add/Update Items…” from the Admin menu.

• Choose “Import…” from the Admin menu.

• Add items to a catalog by dragging files over the Fetch icon in the

Finder.

• Create a new catalog by dragging files over the Fetch icon in the

Finder when there is no default catalog.

The defaults that ship with the product work for most files under most

circumstances. You can change these options at any time, return to the

previous defaults, or create your own. If you prefer not to see this dialog

box each time, choose “Preferences…” from the Edit menu, then check

“Skip Add/Update Dialog” in the “Preferences” dialog box.

The “Add/Update Options” dialog box

7

7

cb da

Use this illustration and the table on the
following page to explore the cataloging
options that Fetch provides. If you are
running System 7, you can open the dia-
log box in Fetch, choose “Show Balloons”
from the Help menu, and use Balloon Help
to explore the different options.

A Click “Save As Default” to save the
current settings as the new default.

B Click “Default” to return to your previ-
ous default settings.

C Click “Done” when you have finished
adding or updating all the items you
want.

D Click “Continue…” to tell Fetch to
start adding or updating the items
using the current settings.
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Catalog update options

Option Choices Description

Modification Method Add; Update; Add and Adds new items only if they do not already exist; updates

Update items only if there have been changes.

Add Unconditionally Adds new items even if they already exist.

Update Unconditionally Updates items even if there have been no changes.

Thumbnail Type(s)1 1-bit; 8-bit; 32-bit Stores 1-bit, 8-bit, or 32-bit thumbnails.

1 and 8-bit; 1 and Stores multiple versions of thumbnails, for optimal

32-bit; 8 and 32-bit; display on different CPUs. 32-bit thumbnails are

1, 8, and 32-bit compressed by QuickTime.

Help… Provides assistance in selecting thumbnail types.

Compressor Criteria2 Any Chooses a compressor arbitrarily.

Speed Chooses the fastest compressor.

Fidelity Chooses the highest-quality image.

Compression Chooses the smallest possible image.

Compressor Type2,3 Fair Quality Chooses speed over image quality.

Best Overall Chooses speed but considers image fidelity.

High Quality Chooses image quality over speed.

Other… Chooses customized level of quality.

File Types Lists all the file types that Fetch currently recognizes.

To check all, press Command + A. To uncheck all, press

Command + Delete. To check or uncheck any one, click

its name.

Extract Keywords* Looks for and extracts any keywords saved with the

source file.

Extract Thumbnail* Looks for and extracts any preview image saved with the

source file. (Note: If you are adding or updating

QuickTime movies, we recommend that you do not use

this option. You will get a larger thumbnail for the movie

if you let Fetch create it rather than extract it.)

Extract Description* Looks for and extracts any description saved with the

source file.

Edit Keywords Opens the “Edit Keywords” dialog box as it adds or

updates each item.

Edit Description Opens the “Edit Description” dialog box as it adds or

updates each item.

Use “Exclusions” File* Excludes any file whose name appears in the “Exclu-

sions…” list. For details, see “Excluding a file from add-

ing or updating.”

.
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Option Choices Description

Include File Name As Keyword Adds the item’s filename to the keyword list.

Include Folder Name As Keyword* Adds the name of the folder where the file is located to

the keyword list.

Mount Remote Volumes* Attempts to mount any unmounted volume that is refer-

enced by an alias.

* Not available during importing.

1Since Fetch installs and uses QuickTime, you should set the default for “Thumbnail Type(s)” to “32-bit.” This setting does not mean larger cata-
logs. In fact, the “32-bit” option means that the thumbnail will be compressed, which will save catalog space, reduce network traffic, and yield a
better-looking thumbnail—even if the original file is less than 32-bits.

2 The “Compressor Criteria” and “Compressor Type” options refer only to the generation of 32-bit thumbnails compressed by QuickTime. They
have no effect on the decompression and previewing of the thumbnails.

3 The recommended setting for “Compressor Type” is “Best Overall.” This setting offers the optimal compromise among thumbnail file size,
thumbnail decompression speed, and thumbnail image quality. If you want a better looking thumbnail, you could set the “Compressor Type” to a
higher-quality setting or JPEG compression. Using a higher quality setting will increase the size of the catalog and, in the case of JPEG compres-
sion, will also increase the amount of time needed to display a thumbnail view in the Gallery window.
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Excluding a file from adding or updating

As you build and modify catalogs, you can tell Aldus Fetch to skip files

of a certain type or name. For example, if you create preseparated DCS

files for a PageMaker publication, you typically want to catalog the com-

posite file only, not the individual separation files. Or if you have a CD-

ROM disc that contains a number of files that are corrupted but cannot

be removed, you can skip those files during cataloging.

• If you want to skip files of a specific type, you can uncheck that file

type in the “File Types” list box in the “Add/Update Options” dialog

box, as described in “Setting catalog update options.” Or you can

remove the file type from the list altogether, using the “File Types…”

command on the Admin menu. For more information about file types

and Fetch, see “Adding a file type.”

• If you want to skip files with a specific name, you can use the proce-

dures described on this and the following pages to create an exclu-

sions list.

You can create an exclusions list by selecting items within an existing

catalog or by giving Fetch an explicit set of names.

• When you have a catalog open, you use the “Add To Exclusions”

command on the Admin menu to add selected items to the exclusions

list. “Add To Exclusions” is dimmed if there are no items selected in

the Gallery or Pasteboard window or if no Preview or Info windows

are open.

• Whether you have a catalog open or not, you can use the “Exclu-

sions…” command on the Admin menu to specify files by name.

In either case, Fetch creates for all catalogs a single exclusions list (Aldus

Fetch™ Exclusions) in the Aldus Fetch™ Preferences folder in the Pref-

erences folder of the System folder (if you are running System 7) or just

loose in the System folder (if you are running System 6.0.7 or 6.0.8). You

can share this list with other users by copying it.

. To add cataloged items to the exclusions list:

1. In the Gallery or Pasteboard window, select the items whose filenames

you want Fetch to skip when adding or updating catalogs in the future.

2. Choose “Add To Exclusions” from the Admin menu.

Fetch exclusions icon
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. To view or modify the exclusions list:

1. Choose “Exclusions…” from the Admin menu.

2. In the “Exclusions” dialog box:

To… Follow this procedure…

Add a name Type the filename you want into the edit box, then click

“Add.”

Pathnames are not allowed.

Case is ignored.

Names can include an asterisk (*) as a wildcard charac-

ter. For example, to tell Fetch to skip the individual sepa-

ration files when updating a DCS file, you can add “*.c,”

“*.y,” “*.m,” and “*.k” to the exclusions list.

Rename an entry Select it in the list box, type a new name in the edit box,

then click “Replace.”

Remove a name Select it in the list box, then click “Delete.”

3. When you have made all the changes you want, click “Done” to close

the dialog box and save the list.

Shortcuts

Delete a filename

(“Delete” button in

“Exclusions” dialog box)

Command + D

Replace a filename

(“Replace” button in

“Exclusions” dialog box)

Command + R

Close dialog box

(“Done” button in

“Exclusions” dialog box)

Command + Return
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Adding a file type

Aldus Fetch can recognize and catalog many types of files, including

those created by the most widely used desktop publishing programs, pre-

sentation programs, and other programs for creating graphics, movies,

sounds, and animations. For a complete list of the file types that Fetch

recognizes, see “Adding a file type.”

Using the “File Types…” button in the “Preferences” dialog box, you

can modify the list by adding, replacing, or deleting file types as long as

the list contains no more than 64 file types at a time. For example, you

might want to add the file type for an application that you use frequently

but whose file type is not currently on the list. Or replace an existing file

type when the manufacturer ships a new version of the product. Or re-

move altogether file types that you do not want to catalog and whose

name you do not want to appear in the list in the Find window or in the

“Add/Update Options” dialog box.

If you add the file type for an application that does not save a preview,

what you see in Fetch is a file icon, not a thumbnail. Although you can-

not preview these files in Fetch, you can enjoy the other benefits of hav-

ing the file cataloged and accessible from within the catalog. In addition,

if the file’s creator application exists on your computer, you can open

and view the file by choosing “Edit Original...” from the Item menu.

Note: When you add or update files that have been compressed using

DiskDoubler, the files are decompressed as needed.
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. To modify the list of file types that Fetch recognizes:

1. Choose “Preferences” from the Edit menu.

2. Click on “File Types….” in the “Preferences” dialog box.

In the “File Types” dialog box:

To… Follow this procedure…

Add a file type In the “Name” edit box, type a description up to 29 char-

acters long. In the “Type” edit box, enter the four-

letter code for the file type you want to add. Choose

“Catalog” under the “Store in:” option if you want the file

type to be added to the list stored with the Catalog file

(a catalog-specific list). Choose “Preferences” under the

“Store in:” option if you want the file type to be added to

the list stored in the Preferences file (a user-defined

default list). Then click “Add.”

OR click “Same type as…” if you are not sure what name

or code to enter. In the resulting file directory dialog box,

select an example of the type of file that you want to add,

then click “Open” to return to the “File Types” dialog box.

Then click “Add.”

OR double-click on one of the file types in the list to auto-

matically enter the information into the “Name” and

“Type” edit boxes. Then click “Add.”

Replace a file type Select it in the list box, type a new name in the edit box,

then click “Replace.”

Remove a file type Select it in the list box, then click “Delete.”

Add the original Select “Add Originals” to add the default list to an

default list to any existing list.

existing list

3. Repeat step 2 as often as you want, then click “Done” to close the dia-

log box and save the revised list.
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The following table lists all of the file types recognized by Fetch at the

time this book went to press. For each file type, the table shows the

application typically used to create it and other applications in which

you can edit it.

File formats

File type Name Created using… Also edited by Able to Preview Thumbnail or icon

8BPS Adobe PhotoShop v2.5 PS2.5 FP1.2 Yes T

8BIM Adobe PhotoShop v2.0 PS2.0, PS2.5 FP1.2 Yes T

FtCF Aldus Fetch Catalog v1.2 FC1.2 n/a No I

FtPJ Aldus Fetch Project v1.2 FC1.2 n/a No I

AGD1 Aldus FreeHand v4 or later FH4 n/a Yes T or I*

sGD1 Aldus FreeHand Template v4 FH4 n/a Yes T or I*

FHD3 Aldus FreeHand v3.11 FH3.11 n/a Yes T or I*

FHT3 Aldus FreeHand Template v3.11 FH3.11 n/a Yes T or I*

FHD3 Aldus FreeHand v3.1 or earlier FH3.1 or earlier n/a No I

FHT3 Aldus FreeHand Template FH3.1 or earlier n/a No I

v3.1 or earlier

ALB5 Aldus PageMaker v5 PM5 n/a Yes T or I*

ALT5 Aldus PageMaker v5 Template PM5 n/a Yes T or I*

ALB4 Aldus PageMaker v4 PM4 PM5 No I

ALT4 Aldus PageMaker v4 Template PM4 PM5 No I

PRS3 Aldus Persuasion v3 PN3 n/a Yes T (Slide one)

PRT3 Aldus Persuasion Template v3 PN3 n/a Yes T (Slide one)

PRS2 Aldus Persuasion v2 PN2 n/a Yes T (Master)

PRT2 Aldus Persuasion Template v2 PN2 n/a Yes T (Master)

AIFF Audio Interchange SE or SEPro n/a Yes I

AIFC Audio Interchange (Compressed) SEPro n/a Yes I

edtp Edition (PICT) App. that supports Publish n/a Yes T

edtt Edition (TEXT) App. that supports Publish n/a Yes T

EPSF EPSF FH, PM, AI, others n/a Yes T

sfil Finder Sound SE or SEPro n/a Yes I

GIFf GIF PC applications, PN2.1+ n/a Yes T (using Easy Open)

RJPG ImpressIt JPEG Radius ImpressIt n/a Yes T

PCDI KODAK Photo CD Your KODAK photo finisher n/a Yes T

PNTG MacPaint MP SP, others Yes T

.
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File type Name Created using… Also edited by Able to Preview Thumbnail or icon

MuAd Multi-Ad Creator MA n/a Yes T or I*

AdSt Multi-Ad Creator Stationery MA n/a Yes T or I*

PICS PICS Animation SC1.6 n/a Yes T

PICT PICT FH, SP, others MD, PS, other Yes T

MooV QuickTime Movie AP, MO n/a Yes T

RIFF RIFF CS, FP, SK1.0 n/a Yes T

FSSD SoundEdit SE, SEPro n/a Yes I

JPEG Storm JPEG PP2.5, PS n/a Yes T

StPP Storm JPEG ++ PP2.5, PS (with plug-in) n/a Yes T

TIFF TIFF PS, scanning applications PS, S32 Yes T

TEXT Text Text Apps, PC graphic apps n/a Yes I

Key to table: AI—Adobe Illustrator; AP—Adobe Premiere; CS—Color Studio; FC—Aldus Fetch; FH—Aldus FreeHand; FP—Fractal Painter;
IS—Image Studio; MA—Multi-Ad Creator; MD—MacDraw; MO—Movie Player; MP—MacPaint; PM—Aldus PageMaker; PP—Picture Press;
PR—Aldus Persuasion; PS—Adobe Photoshop; S32—Studio 32; SC—SuperCard; SD—SoundDesigner; SE—SoundEdit; SK—Sketcher;
SP—SuperPaint.

* A thumbnail is available for this file if one was defined with the original application. Otherwise, Fetch will display the file icon for the file.
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Organizing a catalog by adding keywords

Each item in a catalog has certain information associated with it, such as

filename, file type, volume, and so on. Each item can also have one or

more keywords associated with it. A keyword is a word or phrase that

you associate with a particular item, allowing you to search for items

quickly.

Like a library with a good subject catalog, a Fetch catalog with a good

keyword list can be a valuable tool for finding the information you need.

In addition, keywords created by other applications can be extracted dur-

ing cataloging if they’re available in the source file or added and edited

later. Each item can have an unlimited list of keywords associated with it

(each up to 31 characters long). In a multiuser environment, a catalog

administrator can control who edits keyword lists for each catalog (see

“Setting catalog privileges”).

If you have the multiuser version of Fetch, be sure to look at the

Keywording Strategies booklet, which describes effective ways to orga-

nize your catalog using keywords.

. To extract keywords from source files when adding the files to a catalog:

Make sure that “Extract Keywords” is checked in the “Add/Update

Options” dialog box, then continue to add or update items.

Fetch then examines each source file for keywords that were previ-

ously created with the source file’s application. As Fetch catalogs the

item, the extracted keywords are added to Fetch’s keyword list for that

item. An extracted keyword appears in italics in the “Keywords” list

box in Text List view or in the Info window and cannot be further

edited from within Fetch. If the option is checked in the Add/Update

dialog box, Fetch also automatically adds the filename and the folder

name of the item as keywords. You can also exclude the source file’s

keywords.

Shortcuts

Open Info window

to see item’s keyword list

(“Get Info” on Item menu)

Command + I or

Double-click filename of item

Open Catalog Info window

to see master keyword list

(“Catalog Info” on File menu)

Double-click left end of

information bar in Gallery or

Pasteboard window

Edit keyword list

(“Keywords” on Edit menu)

Command + Y or

Double-click “Keywords” in item’s

Info window
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Tip

If the “Edit Keywords” dialog box is

blocking part of the screen you need

to see, you can move the dialog box

out of the way by dragging it.

. To enter keywords manually while adding items to a catalog:

1. Make sure that “Edit Keywords” is checked in the “Add/Update

Options” dialog box, then continue to add or update items.

Fetch displays the “Edit Keywords” dialog box as it examines each

item before adding it to the catalog.

2. Enter one or more keywords, then click “OK” to return to the “Modifi-

cation Status” box and continue with the next item.

. To display the existing keyword list for an item:

Select the item, then choose “Get Info…” from the Item menu. A

above the list indicates that you do not have permission to edit the list.

or

Select the item from the Text List view of the Gallery or Pasteboard

window.

. To edit the keyword list for a single item:

1. Select the item, then choose “Keywords…” from the Edit menu.

Or display the keyword list as described above, then double-click the

word “Keywords” below the list box.

Note: If “Keywords…” is dimmed on the Edit menu, you do not have

permission to edit keywords for items in the open catalog. If you’re us-

ing the multiuser version of Fetch, check with your catalog

administrator.

The list box on the right contains any
keywords added during or after cataloging.
These appear in normal type in all keyword
lists and can be edited by those with
permission to do so.

The list box on the left contains any
keywords extracted from the item’s source
file. These appear in italics in the combined
keyword list and cannot be edited
within Fetch.
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2. In the edit box:

To… Do this…

Add a new keyword Type the word, then click “Add” (or press Return).

Remove a keyword Select it, then click “Delete” (or press Command + D)

Change a keyword Select it, type the new wording, and then click

“Replace” (or press Command + R).

Note: Fetch automatically removes a keyword from the master key-

word list if there is no item associated with the keyword. Therefore,

when you delete or purge an item from the catalog, any keywords

associated with the item are deleted from the master list.

3. Click “Done” (or press Command + Return) to save the changes and

close the dialog box.

. To add the same set of keywords to multiple items at once:

1. Select the items you want, then choose “Keywords…” from the Edit

menu.

2. In the “Edit Keywords” dialog box, enter the keywords you want as

described above.

3. Click “Done” to save the changes and close the dialog box.

. To print the master keyword list:

1. Choose “Export…” from the Admin menu when the Catalog Info win-

dow is active.

2. In the “Save As” dialog box, enter a name, then click “OK.”

3. Open the file in a word-processing program and print the list from

there.

Note: You cannot make changes to the keyword list in a word-

processing program and then import the list back into Fetch. You

can␣make changes only within Fetch.
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Adding descriptions

In addition to adding keywords to any item, you can add a description up

to 32,000 characters long. You can use the description field to keep track

of any information about the source file that you might find useful or

important. For example, you might use a description to keep notes about

the origin of an item or how it should be used. The description for a photo

image could include notes about who took the original photograph, where

the original is stored, who scanned the image, the scanner settings, copy-

right, and agency or contact information.

If the original application provides a way for you to enter and save

descriptive text with the source file, you can often have Fetch extract

this␣information automatically as it catalogs the item. Otherwise, you

can add or edit a description either during or after cataloging. It is rec-

ommended that you create descriptions in your favorite word-processing

program, then paste them into the description field. In a multiuser envi-

ronment, a catalog administrator can control who edits descriptions.

For␣more information on catalog administration, see “Setting catalog

privileges.”

. To extract descriptions while adding items to a catalog:

Make sure that “Extract Description” is checked in the “Add/Update

Options” dialog box, then continue to add or update items as described

earlier in this chapter.

Fetch then examines each source file it catalogs for a description and

adds it to the catalog entry for the item. An extracted description ap-

pears in italics in the “Descriptions” field in Text List view or in the

Info window and cannot be further edited from within Fetch.

. To enter descriptions manually while adding items to a catalog:

1. Make sure that “Edit Description” is checked in the “Add/Update

Options” dialog box, then continue to add or update items as described

in “Updating and adding items to a catalog.”

Fetch then displays the “Edit Description” dialog box as it scans each

item to add to the catalog.

2. Type or paste a description, then click “OK” to return to the “Modifi-

cation Status” box.

Shortcuts

Open Info window

to see item description

(“Get Info” on Item menu)

Command + I or

Double-click filename of item

Edit description

(“Description” on Edit menu)

Command + U or

Double-click “Description”
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. To display the description for an item:

Select the item, then choose “Get Info…” from the Item menu.

or

Select the item in Text List view of the Gallery or Pasteboard window.

. To edit the description for an item:

1. Select the item, then choose “Description…” from the Edit menu. Or

display the description as described above, then double-click the word

“Description” below the list box.

Note: If “Keywords…” is dimmed on the Edit menu, you do not have

permission to edit keywords for items in the open catalog. If you have

the multiuser version of Fetch, check with your catalog administrator.

The list box on the right contains the
description added during or after
cataloging. This appears in normal type in
the combined description field and can be
edited by those with permission to do so.

The list box on the left contains the description, if any,
extracted from the item’s source file. This appears in
italics in the combined description field and cannot be
edited within Fetch.

2. In the box on the right, type or paste new text.

3. Click “Done” (or press Command + Return) to save the description

and close the dialog box.

Tips

If the “Edit Description” dialog box is

blocking part of the screen you need

to see, you can move the dialog box

out of the way by dragging it.

To enter the same description for a

number of different items, you can

use the Clipboard. For example, if

you scan a number of images using

the same scanner settings, you can

enter the description of the settings

in the description field for one of the

items, then use “Select All” and

“Copy” to copy the description to the

Clipboard. From the Clipboard, you

can paste the same description into

the description field for each of the

remaining items.
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Maintaining a catalog

Catalogs—especially large ones—that are heavily used and frequently

updated can become out-of-date. In addition to routinely backing up all

catalogs and source files (and keeping the backups in a safe place), it is a

good idea to perform other housecleaning tasks regularly as well.

The Admin menu provides the catalog manager or administrator with

tools that can help with everything from routine catalog maintenance to

attempting to recover a catalog if something does go wrong.

Merging catalog contents

The “Export…” and “Import…” commands let you merge complete or

partial contents of catalogs, create new ones from old ones, convert a

Multi-Ad Search catalog to a Fetch catalog, or recatalog the recovered

contents of a damaged catalog. Exporting and importing is also a useful

way to back up a catalog, to compact a catalog from which you regularly

delete numbers of items, and to keep a catalog in good repair.

When you export and import catalogs, Fetch keeps track of thumbnails,

keywords, and descriptions so that you do not lose valuable catalog

information.

. To export a catalog:

1. Open the source catalog and use the Find window to retrieve and

select the items you want to add to the destination catalog.

Use “Find All” and “Select All” if you want to export the entire cata-

log. Or copy selected items to the Pasteboard window (in the order in

which you want them in the new catalog), then select all the items in

the Pasteboard window.

2. Choose “Export…” from the Admin menu.

3. In the file directory dialog box, enter a name for the export file, then

click “Save.”

Tip

To convert a catalog originally cre-

ated in Multi-Ad Search, open the

catalog in Version 1.0 of Multi-Ad

Search, then export it. Open Aldus

Fetch, create a new catalog or open

an existing one, and then import the

exported Multi-Ad Search catalog.

Important!

If you create a project in a catalog

and then delete items prior to ex-

porting that catalog, the project may

no longer display the correct items

in the imported catalog. Exporting

and then importing a project into a

new or different catalog reassigns

the project’s ID, so the project may

point to incorrect items in the new

catalog.
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. To import a catalog:

1. Open the destination catalog. Or create a new, empty catalog.

2. Choose “Import…” from the Admin menu.

3. Check the settings in the “Add/Update Options” dialog box, then click

“Continue….”

4. In the file directory dialog box, select the exported file, then click

“Import.” Importing a catalog may take a significant amount of time.

Removing items from a catalog

Together, the “Delete…,” “Purge…,” and “Volumes…” commands let

you clear the database of unwanted or out-of-date items or references.

Admin menu commands for removing items

Use this command… To…

Delete… Remove selected items outright.

Purge… Remove selected items whose source files you suspect

may no longer be available.

Volumes… Remove a volume reference from the catalog after all

items that referred to that volume have been deleted.

Note: If you use any of these commands, Fetch will automatically purge any unused keywords

associated with the items or volumes that you have removed.

. To remove items from the catalog:

1. Select the items you want to delete.

2. Choose “Delete…” from the Admin menu.

3. Click “OK” to confirm the deletion.
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. To remove items whose source files may no longer be available:

1. In the Gallery or Pasteboard window, select the items that you want to

check.

2. Choose “Purge Items…” from the Admin menu.

Fetch tries to locate the source files for the selected items, then dis-

plays the names of any it cannot find.

3. Select one or more items from the list box, then click “Purge.”

4. Click “Done” to close the dialog box.

. To remove a volume whose items have all been deleted:

1. Choose “Volumes…” from the Admin menu.

In the “Volumes” dialog box, Fetch lists the names of all the volumes

referenced in the catalog.

2. Select a name from the list box, then click “Delete.”

3. Click “OK” to confirm the deletion, then click “Done” to close the

dialog box.

Decreasing catalog size after removing items

Removing items from a catalog does not decrease its file size. The

vacancy in the catalog created by the removed items still contributes

to␣the file size.

If you want to decrease your catalog’s file size after removing items,

you␣must export the catalog, create a new catalog, and then import the

exported catalog into the newly created one.
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Checking and recovering a damaged catalog

When you suspect that a catalog may be damaged, first try rebuilding

your desktop (press and hold down Option + Command while restart-

ing), then verify the catalog. As a last resort, if you have a catalog that

you cannot open at all, recover the catalog and import the recovered con-

tents into a new, empty catalog.

. To verify a catalog:

1. Open the catalog.

2. Choose “Verify…” from the Admin menu.

3. Click “OK” in response to the prompt that asks you to confirm that

you want to verify.

Verifying a large catalog can take a long time, so you may want to be

sure that you are not tying up either the catalog itself or the computer

when you or others need them.

Fetch checks the catalog, performs any necessary repairs that it can, and

then informs you when the verification is complete. It shouldn’t be nec-

essary to verify catalogs often, but you might plan on doing it once in a

while for heavily used catalogs.

. To recover the contents of a damaged catalog:

1. Open any existing catalog or create a new one.

2. Choose “Recover…” from the Admin menu.

3. Click “OK” in response to the prompt that asks you to close the cur-

rent catalog.

4. Click “OK” in response to the prompt that asks you to confirm that

you want to recover a catalog.

5. In the file directory dialog box, choose the name of the damaged cata-

log, then click “Open.”

Recovery is often almost immediate. When recovery is finished, open

the recovered catalog, export its contents, and then import it into a new,

empty catalog.

Note: If you try to open a corrupted catalog or project, Fetch will display

a database error. You must then quit and restart Fetch before you can

open another catalog or project.
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Setting catalog privileges

An Aldus Fetch catalog is considered protected if a password is required

for access to the commands on the Admin menu or unprotected if no

password is required. Password protection is strongly recommended

when a catalog is available to multiple users across a network, but not

necessary if you are the single user of a catalog on your own computer.

With the multiuser version of Fetch, multiple users can open and search

a protected catalog and can preview, print, copy, or edit the items in it.

They can also edit keywords and descriptions at the discretion of a cata-

log administrator. They cannot, however, add new items, update existing

items, or delete items from the catalog.

. To set or change the password for a catalog:

1. Open the catalog.

2. Choose “Privileges…” from the Admin menu.

3. Click “Set Password…” in the “Privileges” dialog box.

4. In the “Set Password” dialog box, type the old password (if there was

one) and the new one twice.

The second time is to verify that the new password is correct. To leave

the catalog unprotected, the password should be blank.

5. Click “OK” once to close the “Set Password” dialog box, then click

“OK” again to close the “Privileges” dialog box and save the new

password.

6. Close the catalog and reopen it to put the changes into effect.

Once a catalog is protected by a password, only one command, “Enter

Password…,” appears on the Admin menu when you open the catalog.

Any user can open the catalog to find, preview, copy, edit, and print

catalog items. Only users who supply the correct password can perform

any of the administrative functions.

Tips

For more information about multiple

user access to Fetch catalogs, see

the next section, “Using Aldus Fetch

on a network.” For information that

may have become available after

this book went to press, refer to the

file ReadMe (Networks), which is in-

cluded only with the multiuser ver-

sion of Fetch.

You cannot set a password if your

user name is blank in the Sharing

Setup control panel (under System 7)

or if your Chooser name is blank

(under System 6).

If you need to know the password for

a catalog, you can open the Catalog

Info window to find out the name of

the last person who set the pass-

word. See “Viewing item or catalog

information.”
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In a multiuser environment, the catalog administrator who sets the pass-

word can also specify whether or not other users can edit keywords or

descriptions. While in the “Privileges” dialog box, check:

• “Edit Keywords” to allow other users to edit keyword lists.

• “Edit Description” to allow other users to edit descriptions.

The “Keywords…” and “Description…” commands on the Edit menu

appear dimmed to any user who does not have permission to edit key-

words and descriptions for the open catalog.
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Using Aldus Fetch on a network

A single Fetch catalog can contain references to source files on multiple

hard disks, servers, CD-ROMs, or floppy disks, whether these media are

mounted or not. When Fetch needs to retrieve a source file (for copying

or editing, for example) that resides on a network volume, it automati-

cally mounts that volume, prompting for a volume password when

required. If a source file is stored on removable media, such as floppy

disks or CD-ROM discs, Fetch prompts for the disk by name. In a

multiuser environment, a shared catalog can be on a network file server

or on any one user’s Macintosh if the Macintosh is running Personal

AppleShare under System 7.

If you are running System 7, Fetch locates source files that have been

moved or renamed on the same volume. (If you are not running System

7, you will have to keep track of these files yourself.)

Network Security Protection

Your license agreement authorizes you to use only one copy of Fetch for

each set of installation disks. When you run Fetch on a network, the pro-

gram checks the network to see whether a copy of the program using the

same serial number is already running. If the program finds that a dupli-

cate serial number is in use, an alert box appears. Click “OK” to close

the alert box. The other user must quit Fetch before you can launch the

copy that you want to use.

If the network fails while Fetch is checking for duplicate serial numbers,

a few seconds may pass before the alert message appears. Normally, the

message appears almost immediately if a duplicate number is found.

Multiuser version of Fetch

In a typical scenario with the multiuser version of Fetch, many users

would open Fetch, locate items they want, and leave Fetch running in the

background while they switch to other applications to edit source files,

work on other documents, read electronic mail, and so forth. Meanwhile,

at any given time, only some of those users would be actively using the

catalog to search for and preview items they might be interested in,

while fewer still might be adding or updating items, keywords, or

descriptions.
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The multiuser version of Fetch allows only one user at a time to modify

(write to) the catalog—that is, edit keywords or descriptions or add or

update items—and temporarily prevents others from making modifica-

tions until that user is done. Other users can, meanwhile, continue to

read the catalog—search, preview, get information, copy, print, and so

forth.

The greater the number of users who have a catalog open, the slower

individual searches will be, depending on what the users are doing with

Fetch. The speed of the network and the server can also affect the perfor-

mance of Fetch.

If a user’s system crashes or is shut down while the user has a shared

catalog open, then Fetch will examine the catalog for damage and tem-

porarily make other users wait until the verification is complete. There-

fore, users should always close and quit to exit a catalog rather than shut

off or restart their systems.

If you want to limit who can write to the catalog, you can set a password

as described in “Setting catalog privileges.” Whether or not your catalog

is password-protected in Fetch, it is essential that you also set up the fol-

lowing network access conditions:

Network access to catalogs and source files

For access to the… The folder that contains it…

Catalog Must be located in folder to which administrators have read and write access. Other

users need at least read access.

Source files Can be located in folders to which different users have different levels of access.

No access is required for users to search, print thumbnails, view thumb-

nails, send or copy references, edit keywords or descriptions

(if permitted), or view most item information.

Read access is required for users to get full item information, preview, print

images, copy items to the Clipboard, or copy source files.

Write access is required for users to edit, move, or delete source files.
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Making a catalog shareable (Single-User Fetch only)

Catalogs created by Single-User Fetch cannot be directly read by the

multiuser version of Fetch. However, Single-User Fetch lets you convert

any catalog for shared use in a multiuser environment. Once converted,

the catalog cannot be directly read by Single-User Fetch, but you can

convert the catalog back to a Single-User catalog anytime. Therefore, a

catalog can be read by only one of version of Fetch—Single-User or

multiuser—at any given time.

If users of both versions of Fetch need to read the same catalog at the

same time, you can always create a copy of the catalog before converting

it, so long as you have sufficient time and disk space to do so.

. To convert a Single-User catalog for use in a multiuser environment:

1. Choose “Convert...” from Fetch’s File menu.

2. In the file open dialog box that appears, select the Single-User catalog

you want to convert by double-clicking on it.

3. The following screen appears:

To convert the catalog, click on “Convert.”

. To convert a shareable catalog for use by Single-User Fetch:

1. Choose “Convert...” from Fetch’s File menu.

2. In the file open dialog box that appears, select the shareable catalog

you want to convert by double-clicking on it.

3. The following screen appears:

To convert the catalog, click on “Convert.”
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Naming and organizing source files

There are many ways to organize the source files for items in an Aldus

Fetch catalog. Each strategy has advantages and disadvantages, but con-

sidering the options and planning ahead can save you time in the long

run and significantly increase the usefulness of Fetch to you and your

workgroup.

One of the key benefits of using Fetch is that you do not need to remem-

ber where a source file is or what it is called. However, because Fetch

can use filenames and folder names as keywords and because you can

then use those keywords to help in searching, a rational plan for naming

and organizing files and folders is helpful.

Each workgroup must ultimately decide what works best for its own

situation based on how the group works and how work flows through it.

Here are a few suggestions that might help in your planning.

Organizing source files

One of the most obvious ways to organize files into folders is to set up a

series of folders for each project, client, or category (for example, travel,

business, architecture). Within a folder, use subfolders to partition

related files appropriately.

Another approach is to organize files into folders by file type, by origi-

nating application, or by originating department (for example, Market-

ing, Sales, Publications).

Once you’ve organized your files into folders, it’s easy to include the

files into catalogs in Fetch.

System 6 or System 7?

Only when you are running System 7

can Fetch keep track of the location

and status of the source files for

items in a catalog. If you are running

System 6, you must keep track of

source files when you copy, move,

delete, rename, or edit them. Hence,

a good naming strategy is all the

more important if you are using

Fetch while running System 6.

Naming source files

Use naming and organizing strategies together to make the most of key-

word searching in Fetch. Once you have decided how to organize your

files, consider the following alternatives for naming them:

• Use extensions to indicate file type, storage medium, status, or any

other attribute that is important to you.

• Use number or alphabetic prefixes to help sort items in ways that

matter for the kinds of files you use. For example, you might use

frame numbers for images from a single photo shoot or counter or

time code readings for sounds, movies, or images digitized from

video or audio tape.
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Appendix A: Summary of Aldus Fetch Shortcuts

For an online reference to Aldus Fetch shortcuts, choose “Fetch Short-

cuts” from the Help menu (System 7) or the Apple menu (System 6).

7  Finder shortcuts

To do this… Use this shortcut…

Add item to default catalog Drag file over Fetch icon when Fetch is not running.

Add item to another catalog Drag file over Fetch icon when Fetch is running and catalog is open.

General window shortcuts

To do this… Use this shortcut…

Open Find window Press Command + F.

Open Gallery window Press Command + R.

Open Pasteboard window Press Command + B.

Open Catalog Info window Double-click left end of information bar in Gallery or Pasteboard window.

Open Preview window Double-click thumbnail. Or select item, then press Return or Command + J.

Open Info window Double-click filename. Or select item, then press Command + I.

Close active window Click close box. Or press Command + W.

Close all secondary windows Press Option + click close box.

Close all windows (and catalog) Press Option + Command + W.
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Find window shortcuts (most also work where applicable in search definition dialog boxes)

To do this… Use this shortcut…

Open Find window or bring to front Press Command + F when Find window is not open or not active.

Open and clear Find window Press Command + Delete.

Retrieve everything in the catalog Press Command + ' (apostrophe).

Expand Find window (“More Choices” ) Press Command + M when Find window is open, active, and reduced.

Reduce Find window (“Fewer Choices” ) Press Command + F when Find window is open, active, and expanded.

Clear search descriptions (“Clear” ) Press Command + Delete.

Repeat previous search Press Command + , (comma).

Carry out default search Press Command + D.

Define, name, and save search Press Command + K.

Gallery and Pasteboard window shortcuts

To do this… In Thumbnail view In Text List view

Open Gallery window or bring to front Press Command + R. Press Command + R.

Open Pasteboard window or bring to front Press Command + B. Press Command + B.

Scroll to beginning or end of window Press Home or End. Press Home or End.

Scroll up or down one screenful Press Page Up or Page Down. Press Page Up or Page Down.

Select item Click thumbnail or text below thumbnail. Click row in list box.

Select next item in direction chosen Press any arrow key. Press up or down arrow key.

Select additional item (discontiguous) Press Command + click new item. Press Command + click new item.

Select all items between last Press Shift + click new item. Press Shift + click new item.

and current item

Select all items in window Press Command + A. Press Command + A.

.
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To do this… In Thumbnail view In Text List view

Copy item from Gallery to Press Control + click thumbnail. Or Select item, then press Control + click

Pasteboard window select item, then press Command + M. thumbnail or press Command + M.

Copy item to Clipboard Select item, then press Command + C. Select item, then press Command + C.

(single item only)

Copy item reference to Clipboard Select item, then press Command + H. Select item, then press Command + H.

with text (multiple selection OK)

Remove item from catalog Select item, then press Delete. Select item, then press Delete.

Remove item from primary window Select item, then press Clear. Select item, then press Clear.

Open Preview window Double-click thumbnail. Or select Select item, then double-click thumb-

item, then press Return or Command + J. nail or press Return or Command + J.

Open Preview window with faster Hold down “G” key while choosing Hold down “G” key while choosing

scrolling and zooming with 32-bit images “Preview” from Item menu. “Preview” from Item menu.

Switch to editing application last Press Option + double-click thumbnail. Select item, then press Option +

associated with item’s file type and Or select item, then press Command + G. double-click thumbnail or press

creator Command + G.

Switch to another editing application Select item, then press Select item, then press

Option + Command + G. Option + Command + G.

Open Info window Double-click text below thumbnail. Double-click row in list box.

Open Catalog Info window Double-click left end of information bar. Double-click left end of information bar.

Open Find window (or bring to front) Double-click middle of information bar. Double-click middle of information bar.

Change view Double-click “Thumbnail View” Double-click “Text List View” in infor-

in information bar. Or press Command + L. mation bar. Or press Command + T.

Print thumbnails of all items in window Press Command + P. Press Command + P.
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Preview window shortcuts: still images (including KODAK Photo CD images)

To do this… Use this shortcut…

Increase magnification and window size Press Command + + (plus sign).

Increase magnification and maintain window size Press Shift + click image.

Decrease magnification and window size Press Command + - (hyphen or minus sign).

Decrease magnification and maintain current window size Press Option + click image.

Return image to actual size (100%); adjust window size to fit Press Command + ` (accent).

Return image to actual size; maintain window size Press Shift + Option + click image. 

Select a portion of the image Drag crosshair cursor over desired part of image, then release.

Zoom in on a portion of the image Shift + drag a selection area. 

Pan image within Preview window Press Command + drag.

Scroll up or down within Preview window Press Page Up or Page Down.

Scroll left or right within Preview window Press Option + Page Up or Page Down.

Scroll to top left or bottom right corner of window Press Home or End.

Scroll a little bit up, down, right, or left Press appropriate arrow key.

Copy item to Pasteboard window Press Command + M.

Copy item to Clipboard Press Command + C.

Copy item reference to Clipboard with text Press Command + H.

Switch to default editing application Press Command + G.

Switch to another editing application Press Option + Command + G.

Return to Gallery window Double-click image. Or press Command + R.

Open Info window (KODAK Photo CD images) Double-click middle of information bar. Or press Command + I.

Open Info window (other types of images) Double-click in information bar. Or press Command + I.

Print image Press Command + P.

Open popup menu (KODAK Photo CD images only) Press and hold down mouse button on ▼ in the information bar.
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Catalog Info window shortcuts

To do this… Use this shortcut…

Find all items that use a keyword Double-click that keyword.

Refresh keyword list Double-click “Keywords.”

Save master keyword list as a text file Choose “Export…” from Admin menu.

Toggle keyword list order Press Option and click “keywords.”

(alphabetical or frequency)

Preview window shortcuts: movies, sounds, animations, and PICS

To do this… Use this shortcut…

Select a frame Click play bar.

Select all frames between last and current frame Shift + click play bar. Or press Shift + drag across slider.

Play or stop movie or sound Press Spacebar. Or double-click to play, single click to pause.

Step forward or backward one frame Press right or left arrow key.

Go to first or last frame Press Home or End.

Increase or decrease volume Press up or down arrow key.

Copy item to Pasteboard window Press Command + M.

Copy item to Clipboard Press Command + C.

Copy item reference to Clipboard with text Press Command + H.

Switch to default editing application Press Command + G.

Switch to another editing application Press Option + Command + G.

Return to Gallery window Press Command + R.

Open popup menu Press and hold down mouse button on ▼ in information bar.

Open Info window Double-click middle of information bar. Or press Command + I.

Hide or display QuickTime control bar (movies only) Press Tab.

Display QuickTime control bar (movies only) Click badge (if present).
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Info window shortcuts

To do this… Use this shortcut…

Display next or previous page of File Info or Fetch Info field Tab key for File Info. Tab + Shift for Fetch Info.

Edit description (noneditable portion is in italics) Double-click “Description.” Or press Command + U.

Find all items that use a keyword Double-click that keyword.

Toggle keyword list order (alphabetical/frequency-of-use) Press Option + click “Keywords.”

Edit keyword list (noneditable keywords are in italics) Double-click “Keywords.” Or press Command + Y.

Open Preview window Double-click thumbnail. Or press Return or Command + J.

Copy item to Pasteboard window Press Command + M.

Copy item to Clipboard Press Command + C.

Copy item reference to Clipboard with text Press Command + H.

Switch to default editing application Press Command + G.

Switch to another editing application Press Option + Command + G.

Return to Gallery window Press Command + R.

Return to Pasteboard window Press Command + B.
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Appendix B: Installed files and their locations

The Aldus Installer/Utility installs the following files and folders on

your hard drive.

In the Aldus Fetch 1.2 folder:

File/Folder Description

Aldus Fetch 1.2 The application.

ReadMe file A TeachText file containing last-minute product information and corrections to this

manual.

ReadMe (Networks) A TeachText file containing last-minute information on using Fetch in a multiuser

(multiuser version of  Fetch only) environment.

Easy Open User Guide A TeachText file containing information on how to use Macintosh Easy Open.

Installer History and Diagnostics files TeachText files that describe the installation history and diagnostics results.

Fetch Extras folder A folder containing other applications or utilities that make Fetch an even more

powerful tool.

Sample Catalog folder A folder containing a sample Fetch catalog and its source files.

In the Aldus folder in your System folder:

File/Folder Description

Utilities folder A folder that contains the Aldus Installer/Utility and a QuickTime-compatible version

of TeachText. Note: This version of TeachText will not be installed if a more recent

version already exists in the Aldus folder.

Fetch 1.2 Resource Document A file that will be used by future versions of Fetch to convert catalogs to new for-

mats. It is very important that you do not delete this file.
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In the Extensions folder in your System folder:

File/Folder Description

QuickTime 1.6.1 An Apple system extension that lets you put animation, video, and sound into your

Macintosh files. It also provides image-compression capabilities. QuickTime files

use the MooV file format.

Macintosh Easy Open An Apple system extension that lets your system open a document when you do not

have the application that created it and converts documents into another program’s

format without opening the documents. You can use Easy Open to define file types

that can be previewed in Fetch.

TGA Translation Extension An Easy Open translation extension that lets you catalog Targa file types in Fetch.

GIF Translation Extension An Easy Open translation extension that lets you catalog GIF file types in Fetch.

In the Apple Menu Items folder in your System folder:

File/Folder Description

Scrapbook A QuickTime-compatible version of the Scrapbook. This version of the Scrapbook

will not be installed if there already exists a more recent version in the Extensions

folder.

In the Control Panels folder in your System folder:

File/Folder Description

Macintosh Easy Open Setup A control panel that lets you define how Easy Open works with your system.
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Index

A

“Add to Exclusions” command 57–58

“Add/Update Items…” command

50–53, 54–56

“Add/Update Options” dialog box

50–53, 54–56, 63

Adding

descriptions 66

file types 59–62

files 51

folders 51, 55

items

to catalogs 50–53, 66–67

to exclusions list 57

to Pasteboard window 41

keywords 65

volumes 51

Administrator 68–70

catalog maintenance 68–70

setting catalog privileges 72–73

Aldus Fetch

administering 68–70

Balloon Help 10

basic information 2–10

exclusions 5

folder 85

interapplication connectivity 33–35

key 5

learning 10, 12

multiuser version 2

online help. See Help

prefs file 5, 19

registering 5

serial number 4

Single-User version 2

starting 12

User Guide 10

using on network 74

Aldus Installer/Utility 10

Aldus Magazine 5

Aliased folder 51

Animation

file types 62

previewing 28

shortcuts 83

Archiving. See Cataloging

B

Backing up

catalogs 68–70

program disks 4

Balloon Help 10

Basics, Aldus Fetch 10, 12

Bitmap. See Image

C

Catalog

adding items 66–67

creating 48

by dragging 48

by selecting 48

defined 2

deleting 69

destination 68

editing. See Editing

excluding files from 57–58

exporting 68

importing 68

maintaining 68–70

making shareable 76

opening 12

protecting 72–73

retrieving items from 16–17

searching. See Searching

setting privileges 72–73

source 68

“Catalog Info…” command 37

Catalog Info window 20, 36–37, 83

Cataloging

adding new catalogs 48

creating catalogs 48

description. See Description

excluding files 57–58

for the first time 6

keywords. See Keyword

maintenance 68–70

setting update options 54–56

updating 50–53

“Choose…” button in “File Types”

menu 59

Clipboard, copying to 21

Color QuickDraw 40

“Compressor Criteria” option 56

“Compressor Type” option 56

Converting catalogs 76

“Copy” command 33–35

“Copy Original…” command 30–32

“Copy Reference” command 33–35

Copying

items 33–35

movie file 34

program disks 4

sound file 34

source file 31

Creating

catalogs 48

projects 43

Customer Services 5

Customizing searches 18

D

Decrease

catalog size 70

magnification 27

“Default Document…” command 39–40

Defaults

catalog 40, 48

document 39

measurements 40

search 39

customizing 18

editing 39

“Define…” command 19, 39

Defining searches 18–19

“Definitions” dialog box 19

“Delete…” command 69

“Delete Original…” command 30–32

Deleting

items 30, 68

source files 30–32

Description 2

adding 66

editing 38, 55, 66–67

extracting 55

in searches 17

unknown file type, selecting 59

uses for 66

“Description…” command 67
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Desktop 5

Destination catalog 68

Disks, making backup copies 4

Dithering images 40

Dragging

to create catalogs 48

to update catalogs 52

Duplicating program disks 4

E

Easy Open. See Macintosh Easy Open

Easy Open User Guide 85

“Edit Description” dialog box 66–67

“Edit Keywords” dialog box 55

“Edit Original” command 30–32

Editing

descriptions 38, 66–67

keyword lists 63–65, 73

source files 21, 30–32

“Enter Password…” command 47, 72

EPSF image 34

Excluding files from catalogs 57–58

“Exclusions…” command 57–58

“Exclusions” dialog box 58

Exporting

catalogs 68

master keyword list 63

Extensions

during installation 4

for GIF and Targa file types 5

for GIF file types 86

for Targa file types 86

Extracting information from source

files 55

F

Fax modem, using in printing 45

“Fetch Shortcuts” command 10

Fetch-awareness 33–35

File

adding 51

adding unknown file type 59

excluding from catalogs 57–58

naming 77

transfering 34

File types

adding 59–62

searching by 16–17

“File Types…” command 59–62

“File Types” dialog box 59–62

Filename

including as keyword 56

searching using 16–17, 18

Find window 12, 13

expanded, for complex searches 17

keyboard shortcuts 80

opening 15, 16, 20

retrieving items using 16–17

Finder

adding items to catalogs 52

creating catalogs 49

shortcuts 79

Finding. See Searching

Folder

adding 51, 55

aliased 51

name as keyword 55

G

Gallery window 65

described 8, 13

displaying results of search 16

opening 15

Text List view 13, 22

Thumbnail view 13, 20

H

Hardware requirements 3

Help

Fetch Shortcuts 79–84

online

Balloon Help 10

Fetch Shortcuts 10

ReadMe files 4, 10

technical support services 5

I
Image. See also KODAK Photo CD

copying 34

EPSF 34

file types 59–62

magnification 26

previewing 26

shortcuts 82

subselecting 26

Importing catalogs 68

Increase magnification 27

Info window 12, 21, 36–37, 84

Installation

backing up disks 4

installed files 85

starting 4

troubleshooting 4

turning off extensions 4

Installer/Utility.

See Aldus Installer/Utility

Interapplication connectivity 33–35

Item

adding to catalogs 50–53, 66–67

adding to Pasteboard window 41

copying to other applications 33–35

defined 2

editing source files 30–32

information for 36–37, 63

retrieving 16–17

searching using Find window 16–17

thumbnail 21

J
JPEG compression 56

Jump to first or last frame 29

K
Keyboard shortcuts. See Shortcuts

Keyword 2

Add/Update options 55

editing 55, 73

editing lists 38, 63–65

extracting 55

list in Info window 37

master list

exporting 63

in Catalog Info window 36

order 37

preferences, setting 40

searching using 16, 18

strategies 64

toggle order 37

KODAK Photo CD

file type 61

memory requirements 3

playing in Preview window 24–26

previewing images 25

L

LaserWriter driver 6.0 46

Learning Aldus Fetch 10, 12

Library. See Catalog

Locating. See Searching
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M

Macintosh

Easy Open User Guide 85

System 6.0.7 3

System 7 3, 79

Macintosh Easy Open

described 5

Magnification of images 26

Maintenance, catalogs 68–70

Measurement system, default 40

Memory

RAM 21

requirements for QuickTime 3

Modem, printing to fax 45

“Modification Status” box 51

“Move Original…” command 30–32

Movie

playing in Preview window

24–26, 28, 29

references 34

setting preferences 40

shortcuts 83

Moving source files 30–32

Multi-user ReadMe 10

Multiple users 74

multiuser version of Fetch

converting catalogs 76

described 2

N

“Name” edit box 60

Naming files 77

Network. See also Administrator

catalog privileges 72

ReadMe 10

security 74

using Fetch on 74

“New Definition” dialog box 19

O

Online help

Balloon Help 10

ReadMe files 4, 10

Shortcuts 10

“Open…” command 12, 43

“Open Project…” command 43

Opening

catalogs 12

Find window 16

information windows 36–37

Preview window 24

projects 43

windows, shortcuts 15, 79–84

P
Pasteboard window 15, 41

Pause

movie 29

sound 25

Photo. See Image. See also KODAK

Photo CD

PICT format 34

Play

movie 29

sound 25

Preferences

file 5

setting 39

“Preferences…” command 39–40

Preview window 12, 24–26, 82

Previewing items 24–26

“Print…” command 45

Printing 45

images 26, 45

options 45

from Preview window 24–26

thumbnails 45

troubleshooting 46

using fax modem 45

“Privileges…” command 72–73

“Privileges” dialog box 72–73

Project, Fetch 43, 68

Protection, network security 74

“Purge…” command 69

Purging items 69

Q
QuickDraw 40

QuickTime 10

file type 62

memory requirements 3

playing in Preview window 24–26

previewing 28

requirements for 24

shortcuts 83

version 1.6 86

R

RAM 21

ReadMe files 4, 10, 85

Reference 43

copying 33

sending 35

transferring 35

Registering Aldus Fetch 5

Removing items. See Deleting.

See also Purging items

Reordering items 21, 23

Retrieving items 16–17.

See also Searching

S

Sample catalog

updating 9

using 9

Sample Catalog folder 85

“Save As Project…” command 43

Saving searches 19

Scrapbook 86

Search definition 18–19

Searching

by file type 16–17, 18

by filename 17, 18

by keywords 16

by volume 16–17, 18

complex searches 17

default search 39

defining searches 16–17

faster 18

keyboard shortcuts 16

saving searches 19

simple searches 17

using Find window 16

viewing results 20–23

Security, network protection 74

Select

cropping image 27

item 21

part of movie 29

“Send Reference” command 33–35

Serial number

Aldus Fetch™ Key file 5

prompt for 4

stickers 5

Setting

catalog privileges 72–73

defaults 39–40

preferences 39–40
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Seven symbol 3

Shared work environment. See Network,

using Fetch on

Shortcuts 79–84

animation 83

Catalog Info window 83

definitions 18

deleting 58

Find window 80

Finder 79

Gallery window 80

Info window 84

movies 83

online 10

opening catalogs 15

opening windows 15

Pasteboard 80

Preview window 24, 82

searching for items 16

sound 83

windows 79

“Show Balloons” command 10

Single-User Fetch

described 2

making shareable catalogs 76

Size

catalog 56, 70

preview image 24

SND format 34

Software requirements 3

Sound

file types 61

playing in Preview window 24–26

previewing 25

shortcuts 83

Source catalog 68

Source file 2, 21, 30–32

Starting Aldus Fetch 12

Startup options, setting 39–40

Still image. See Image

Support services 5

System 7

Finder shortcuts 79

network usage 74–75

requirements 3

System requirements

for Fetch 3

for QuickTime 24

T

Technical support services 5

Text List view 13, 20, 66

shortcuts 80

viewing search results in 22

Thumbnail

display options 55

editing descriptions 66–67

in Info window 37

printing 45

printing using fax modem 45

in projects 43

Thumbnail view 13, 20, 80

TIFF image, file types 62

Toggle keyword order 37

Transferring items to other

applications 33–35

Troubleshooting

adding unknown file type 59

damaged catalogs, repairing 71

installation 4

printing problems 46

repairing damaged catalogs 71

updating large catalogs 57–58

U

Updating catalogs 68–70

User Guide 10

V

“Verify…” command 71

Viewing

exclusions list 58

Pasteboard window contents 41

QuickTime movies 10

search results 20–23

Virus protection 4

Volume

adding 51

searching by 16–17, 18

W

Windows

Find 12

Gallery 12, 80

Info 12

keyboard shortcuts 79

Pasteboard 41, 80

Preview 12, 24–26, 82

Workgroup

administration 68–70

network, Fetch on 74

Working with other applications 33–35

Z

Zooming in on images 26
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